A
v

O’REILLY"

GERARD NIEMETZKY
DOMINIQUE LEGRAND
ANTONY LEGRAND
ERIC MAHE

VINCENT RISACHER

Tnanslated by
MARIE-LAURE CLEC'H

FRANCOIS QUINIO
THIBAUT GRANIER
POISSON ROUGE
CYRIL BRUNEAU




GERARD NIEMETZKY |
duviser and trainer in celor management
and numexical printing PAGE 6

DOMINQUE LEGRAND & ANTONY LEGRAND |
Juainexs [Experts in numevical imaging PAGE 14

ERIC MAHE |
Jmage creater PAGE 28

VINCENT RISACHER |
Pheteengraver PAGE 36




Photo Retouching
~ with Photoshop




A Designer’s Notebook

Photo Retouching
with Photoshop

GERARD NIEMETZKY
DOMINIQUE LEGRAND
ANTONY LEGRAND
ERIC MAHE
VINCENT RISACHER
FRANCOIS QUINIO
THIBAUT GRANIER
POISSON ROUGE

CYRIL BRUNEAU

TRANSLATED BY

MARIE-LAURE CLEC’H

O’REILLY"

Beijing * Cambridge * Farnham * K&ln ¢ Paris * Sebastopol * Taipei * Tokyo



Photo Retouching with Photoshop: A Designer’'s Notebook
by Gérard Niemetzky, Dominique Legrand, Antony Legrand, Eric Mahé, Vincent Risacher, Frangois Quinio,
Thibaut Granier, Poisson Rouge, and Cyril Bruneau

Translated by Marie-Laure CLEC'H

Translation © 2005 O'Reilly Media, Inc. All rights reserved.
Printed in Italy.

Published by O'Reilly Media, Inc., 1005 Gravenstein Highway North, Sebastopol, CA 95472.

Translation from the French language edition of: Retouches Photo avec Photoshop - Les cahiers des Designers
05 by Gérard Niemetzky, Dominique Legrand, Antony Legrand, Eric Mahé, Vincent Risacher, Francois Quinio,
Thibaut Granier, Poisson Rouge, and Cyril Bruneau. © 2003 Editions Eyrolles, Paris, France.

O'Reilly books may be purchased for educational, business, or sales promotional use. Online editions are also
available for most titles (safari.oreilly.com). For more information, contact our corporate/institutional sales
department: (800) 998-9938 or corporate@oreilly.com.

Editor: Robert Eckstein

Art Director: Michele Wetherbee
Production Editor: Darren Kelly

Cover Designer: Volume Design, Inc.
Interior Designer: Anne Kilgore

Printing History:
December 2004:  First Edition.
The O'Reilly logo is a registered trademark of O'Reilly Media, Inc. The Designer’s Notebook

series designations, Photo Retouching with Photoshop: A Designer’s Notebook, and related trade dress
are trademarks of O'Reilly Media, Inc.

Many of the designations used by manufacturers and sellers to distinguish their products are claimed
as trademarks. Where those designations appear in this book, and O'Reilly Media, Inc. was aware of a

trademark claim, the designations have been printed in caps or initial caps.

While every precaution has been taken in the preparation of this book, the publisher and authors assume
no responsibility for errors or omissions, or for damages resulting from the use of the information
contained herein.

ISBN: 0-596-00860-0

(L]



Contents

Studio 1: Image Restoring
Gérard Niemetzky

Studio 2: Digital Surgery
Dominique and Antony Legrand

Studio 3: Late Afternoon in Nosy Be
Eric Mahé

Studio 4: Beauty Institut
Vincent Risacher

Studio 5: Sails, Perspectives, and Curves
Francois Quinio

Studio 6: Bloody Mallory
Thibaut Granier

Studio 7: Firefly
Poisson Rouge

Studio 8: Aroma
Cyril Bruneau

14

28

36

46

58

68

78



. ! / } D L “
jvme J1vpié P;tv{‘m’rtvn vheri ofij (A
.o / / [+
@y A v:ﬁ 1;-1-»*1”1"!:.{ B ‘ 1,(*4 f‘pr v1{e.
L ovfing

/ 3
:;’w’f’?m ‘w‘d..; A

] -f— lj ;!'
v:frt 4 il :JI BAREY Ads mwwlj—
'LLH-'LL [vu.,; Ad v

B n'nt’w“/ ant ‘L v”'\.l é h nvefevve

S i - ;
A baad e Ai’ hv"fi% -V&‘ le avy fu tome;
g g

« 11
Wi (4 w‘!: AL e :;hwu /EJ‘(E»»/’U»»H

I ! . /
All ;rvu have to dv it thove the

(Lrltk("t’/’! e Tia L+) Jv b{x 1 (A

;‘E.;;r:-wt. [r‘f,’ .“uv‘,E ‘114,,1/1}16 ;vrtewe’ve: z/vu
wftwf i ILAF C-rt'vfnt'ff'. fia CL{L, ;,ne vu*"rf
f.,t w.!] Hor sy weed L"v Ao 1L ft/.ft'nﬁ

= ) =
f‘a/,tfjl I ;14.6/4 rS ((, b—-RDMJ} 1L.v ff’]tf"

| f "
&"ﬁe,j‘{; vechvlogiel.

f
AR m{



Hardware used
= Epson 2450 Scanner
= Epson Printer
= PowerBook G4 667 - 512 MB of RAM

Software used
» Photoshop CS

. s | was working on a historical family album, | came across :
% photographs that were over a hundred years old. Some : 2 s 'Fjwk/[, 5mﬂﬂ6
were still in good condition, others required intensive \
restoration work. \

Since the goal was to print them out and put them on a CD- W
ROM for each member of the family, it seemed to me that the
best way to go about it was to scan them and use Photoshop
to touch them up.

This magnificent, early twentieth-century portrait represents
my grandfather when he was child. | knew that | had to save
the original paperboard support, bearing the name of the pho-
tographer, along with the picture.

The work consisted of restoring th € PhOtO and saving
the original paperboard support
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Erantane the 1 I used a 100% ratio to scan the pho-
mg € image - tograph, and a 300 dpi resolution.

= ~ This was sufficient to print the photo-
graph on a good quality ink-jet
printer. As for the CD-ROM version of
the image, | didnt need such a high
definition version; it could be reduced

In order to save the image, my first idea was
to scan the original photograph vertically—
this is, following the vertical scrolling of the
sensors of the scanner. However, since the
light follows the same direction as the sen-
sors, this made it impossible to preserve the
embossed aspect of the frame which gave
the photograph its specific relief effect.

later on. =

On the other hand, by turning the image to
a 90° angle, a shade was created during the
scanning operation that resulted in a con-
trast. This contrast was sufficient to preserve
that impression of relief.

_fcm»er mef;er .feh'ﬁ p-JJ' fvr Cv-to-r %
manAgement that take into accomnt the
Vvﬁ Izb VJ: H"& Jtar ey MA convert Hw

| image inte Advlee RGR wrkrrmcz.

fcan cavvied out at 4 90° angle which
adlons J:w A Jur;w s wmove accentunted

baclgromnd, thanles to a thade effect.

Although | was dealing with a black and white picture, |
scanned it using RGB colors in order to preserve the faded,
sepia shade that is so typical of old prints.

e



Stage

How to manage color

As a true believer of color management through ICC profiles,
I used a profile that was specific to my scanner in order to ac-
quire this image. | opened it in a Photoshop “photographic”
space—in this case, the Adobe RGB (1998) space. For this par-
ticular monochromatic image, the work that was done on
levels shown below was done in the Lab color space, on layer
L (luminosity). This made it possible to preserve the delicate
shades of the photograph. Once the image was scanned, | im-
mediately switched from the RGB mode to Lab colors.

Before | start, | always set the values of the image back where
they belong using the Image > Adjustments->Levels command.

P - { oprions... )
Output Levels: [0 255 | ZIA7

- g = E Preview

Adjniting the entry levels of the white awd
ltlacle Tw’iu—f;{ in vider to velsndance Hw

 values vf the ‘imhﬂb,
Channel: _L.___m__.j
input Levels:[159 | 141|221 %’
(Clead.. )
i (e ) g
{ Aut;—_j
B ey - (_ Options... )
Output Levels: |0 255 i
e ces
- < ™ Preview

01 - lmﬂ.ﬂ& R&Iﬁrri»j

[X1EK)

[ oo GO i O To make sure that | can come
toms 1) ovecnrfioox I back to these adjustments later
we: O F+[@]  mefoox

b 72 = " Adi
S 1 T on, | use a “Levels” Adjustment
Layer.

As with real photographic prints, you should never decide what
should be retouched on an image until you correct the expo-
sure. Thanks to this adjustment, all the main values of the im-
age are perfectly placed: white point, black point, and contrast.
Now | can decide which corrections | need to carry out on this
image. =
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| et e e e
L -
This phase gave me time to reflect on the steps | needed to
S t a e perform. | wanted to keep this process both simple and logi-
9 = . cal. That way, touching up was much easier and | had time to

concentrate on flaws.
What needed touching up
on this picture?
This was a critical phase. The time had come to decide exactly
what | wanted to do with the picture: more specifically, the or-

der in which | was going to proceed and the tools | was go-

ing to use. Remove ﬂfw.r [t leep

Jome me’:d vat J’;w-w
the AgEing vql: the

[tonnd
I typically avoid making pApEydears.

localized corrections on

! s
an image. Global correc- IT‘”"‘{“' 5 t,;w £ N
tions, in terms of phot vaph, Keep | : =
chroma, are often more - Inrbace in £ 3
effective. However, in W&k}ww»ﬁ{, ; " &

this particular case, |
had to first work on the
photograph itself, since
it had lost most of its
density, details, and
contrast. Next, | had to
work on the frame,
which had kept its orig-
inal color. So | started
by selecting the image 4&75' vid of
in order to improve it, [tlack sz.
then | reversed the se-

lection in order to touch

up the frame.

3 [
Tmprove JAavpnel].

Covvect the ”’ﬂ e

For this specific type of restoration work, |
used the following steps:

= Select the photo
= Correct the values
» Increase the sharpness
= Clean and touch up the photograph
first, then its paperboard frame P
= Repair the edge of the photograph \
and the frame. =

1

4&# vid O'JE L‘m‘t(/( while

. s [
lpre,rww»j VEHE:&C.

Covvect the em’je adl avesnid the frfme.



Stage|

Selecting and correcting the portrait

Since the part | need to edit here is rectangular, | positioned
the Rectangular Marquee Selection along the four sides of the
picture before making a precise selection of the entire portrait.

Lab space.
Channel. L B
| Reset |
— A (toad. )
G
] =
. A R B B T |
s
L EL
mput | %
ouwput| % | _Fd
- ==

Next, | created a Curves Adjustment
Layer in order to modify it. | did this
using Layer>~New Adjustment Layer->
Curves. On this figure, you can see the
shape of the curve | used, on layer L of

Finally, by reversing
the selection (Select
>Inverse), | could
work on the paper-
board frame. | did
not want to sharpen
the frame because
this would have em-
phasized the details
of the paper, thus
giving it an artificial
feel. | did not want
to add more grain to

the paperboard either, since it looked quite nice once scanned.
It was only after | had corrected the values of the image (us-
ing the Curves effect) and then sharpened it that | could actu-
ally clean it. Touching up the image before applying a
sharpening filter can ruin what has been done so far, since it

magnifies all the flaws and dust. =

01 — hwage Rettoring I

The Lals colov J'TM-J

¢ it wy favovite tool for H;;
l6nd vf werits allows fvr the covvective VJ:

Vwi»&.f annd contradt vf the imange o l,ajw | &

N‘FHW'Wf,' krl/i?bﬁwj colnrr..f. Pl

L that | apply wy tharperi=g f

alto o thit lager

LW?»J move cLﬂuﬁfj 174 Hw rvrf?rm'f:-

lter in ovder tv
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Touching up the photograph
and the frame

| switched back to Adobe RGB color space before | started
touching up the picture (Image>Mode>RGB Colors). At the
very end, the image was saved using this color space. (In fact,
it was printed in RGB on my ink-jet printer and RGB was used
again when | saved it on my CD.)

The Clone Stamp was the best tool for

this photograph, and | used it to touch
up the dust and scratches.

First, | Alt+Clicked to select the source
that | was going to clone from.

By selecting various brushes with de-
grees of sharpness, | could correct
these flaws with precision.

This “cloning” made it possible to
erase the tear of the frame and the
flaws of the photograph. =

Doc- 2.16M/ 2 16M »

'Youndong

fARG AT A )

uf @ /8)

Doc: 2 16N 2. 16M

Iel%ﬁwj the zowe that
weed! Lo lte tprbmxtad

Applj’?wj t/w Cﬂhri&w Zont
over the part that weeds
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Touching up the edges of the
photograph and the frame

N I

: I used the same tool (Clone
Stamp) to create an artificial
edge all around the time-worn
paperboard and to touch up the
tear of the frame.

b -m|ﬂmte» it

| kept some of the darker areas to give the whole thing
: an older look. Of course, this is a matter of taste. It
3 = would have been possible to clean the paperboard
t 5 completely.

Choosing the size of the brush—
as well as the degree of sharpness
that the brush uses—a_long the . M‘F"D

edge of the area that is cloned R +:
makes it possible to adapt and B
correct different sized flaws. It 1l 2 Since the image that was intended to be viewed on screen only,

| re-sampled the image at 72 dpi and saved it as a JPEG in order
to record on CD-ROM. Note that | had previously converted it to

also allows for both precise
cloning of a specific part of the
image (sharp clone) or the correc-
tion of a flaw (hazy clone).

the RGB color space, which is required for multimedia use.
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Hardware used
= Macintosh G4 - 1 GB RAM + Macintosh iBook Combo
384 MB RAM
= Calibration and screen profile: Monitor Expert Calibrator
from Alwan Color Expertise
= Wacom graphic tablet

Software used
= Photoshop CS

his workshop was meant to demonstrate how Photoshop

works. It was used at the Adobe booth during the 2002
Apple Exhibition. It now serves as an exercise during a training
course on professional retouching for anyone who wants to use
this software more efficiently and wants to understand it better.

We asked photographers Jean-Louis Scotto and Eric
Quakine, who created and run the Marseille-based Eloroann
School for Top Models, if they would mind helping us with this
project. During photography sessions, they would assist by
making mistakes on purpose so that we could work on them
later and retouch them. The picture we selected for this exer-
cise was that of Prescilia. It required significant corrections:
framing, distortion, lighting . . . it's a good thing this is a fic-
tional photograph, as a professional photographer would never
get away with such grave errors!

DOMINIQUE LEGRAND
ANTONY LEGRAND

Fiwal ’mﬁﬂ ¢

The photograph required significant (CO rrectl ons:
framing, distortion, lighting . . .
15
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3
Stage |

Profile Shot . ..

The backArep

The idea behind this image

oo [loadi he
shands ond Broww by f“-"ﬁ “J  was to show Prescilia pro-
* . jecting herself into reality,

Beacn l”(v!’e Tir J : g ; y
liacleArep wickure as if jumping out of a pic-

e ' -
,(“".r‘_"‘f 1 The Ton model L waun"wy
Ad 1y I

A {n';‘\duf }

Colov linclegroen

We asked Jean-Louis and Eric to
play the part of tyrannical cus-
tomers and to make their com-
ments directly in Photoshop in the
form of small annotations.

ture that was on a wall. (Of
course, her image would
remain on the wall!) Note
that our objective is to
focus on Prescilia and on
any touching up that had
to be done, not on creat-
ing the photomontage it-
self.

For ‘ "_'j )

Calibration

Before | start retouching any picture, | always check
the calibration of my monitor and use my colorime-
ter so that the colors that show on the screen cor-
respond to the numeric data of the file. This way, |
can check the veracity of the colors. It is simply un-
thinkable to work on an inaccurate screen.

Info 0=0
/ Calibrate\ /Options \ /' Measurements \
Custom 3| _EI

| ®Gamma1es @®Ds50 @ Lum. 70 cd/m2
QO Gamma22 (D65 (O Lum.85cdm2

_Screen 2 Profile
White :

| Maximum intensity : 73 cd/m2
Temperature : 5020°K x = 0.3452 y: 03581
Chromaticity :

Red: x=0.6357 y=0.3398 Gamma

=] Elorcann

Face: add some locks
outside framing. Be
careful with the
outline!

.

Eloroann

=1.80
| Green : x = 0.2974 y = 0.6081 Gamma = 1.79
 Blue: x=0.1526 y=0.0807 Gamma = 1.80
| 8 Black-Sh :  Dymanics :
AL (CIELAB) : 5.7 D=892:1

Thursday September 26, 2002 23:37:26

Improve detail of
bikini: we do not
see the stitches
enough. Get rid of
transparency: we
can see the bra cup.
Check color.

Her back
should be
more arched.

(=] Elorcann
Remove the
hollow of her
thigh. (I know
it is natural,
but it does not
look nice!) "

((_Amoiant ignt_}| (417 lux Tp=4977°K |
| Screen effect ’ .03 lux

This calibration, using
French software, met the
ICC and ISO standards
(5000°K color tempera-
ture, Gamma 1.8 on Mac).
The profile of the monitor

=] Eloroann

also corresponded to RGB

Skin color (tan) should be
more even. Get rid of
some little flaws (wrinkles,

shadows, blemishes,
scratches . . ).

“Colormatch” workspace
which | chose among the
range of colors Photoshop
Preferences offers.
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Color Settings

Settings:  Custom ——— Stage
g Advanced M
Working Spaces
RGB:  ColorMatch RGBS -?]
CMYK:  Euroscale Coated v2 _:'
Gray:| Dot Gain 15% Tl
Spot: Dot Gain 15% T'
Color Management Policies o

RGB:  Preserve Embedded Profiles $)
)

Gray:  Preserve Embedded Profiles = l’

CMYK:  Preserve Embedded Profiles

Profile Mismatches: [ Ask when Open ng # Ask when Pasting
Missing Profiles: i Ask when Opening

Conversion Options

Engine:  Apple ColorSync :!
ntent:  Perceptua v l
q Use Black Point Compensation @ Use Dither {8-bit/channel images

~
Colvv _1;;’6.»&:;‘&»—»(&,!’

worked on this image as an RGB file. However, | could simu-

late, on screen, the colors that | would get using the CMYK
space. To do this, select the CMYK “profile” inside the Color
Settings (CMYK workspace) at Edit>Color Settings

RGN Window Help

Proof Setup >
Proof Colors
Gamut Warning

Zoom In X+
Zoom Qut Xx-
Fit on Screen *®0

Actual Pixels N¥0
Print Size

CMYK allows me to produce a customized quadric for the
printer. Hopefully, my client would at some point provide me
with the profile of the offset press that would be used to print
on a defined paper. However, since | did not have that infor-

mation at the time, | picked the Euroscale coated V2 standard.

| could then touch up the image in either RGB or Lab modes,
in order to work in a vast colorimetric space and benefit from
all the functions and filters Photoshop can offer. Later on, the
conversion from RGB mode toward CMYK separation will be
nothing more than a mere formality at the end of the chain—
for example in the RIP of the CTP.
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Color Insurance

When | save my photos in Photoshop, the profile of my work-
space (here, Colormatch) is attached automatically, so that the
person who receives it knows the origin—the source, if you
will—of the colors | have used. If the file is opened under any
other working conditions, the numeric data will be converted
so as to preserve the true colors of the ariginal file (and not
the reverse, as one might think).

In the absence of such information, | gave the image my
own workspace settings and adjusted the colors to my liking.
Where were the “true colors”? Well, be careful. If | wanted to
stay true to the red color of the bikini, | would need either a
sample of it or its Lab values. | might even have to observe its
fabric under a 5000K light with a standardized intensity. Then,
on my calibrated screen, | could reproduce the exact color of
the bikini and check if I could print it in CMYK in the same sat-
uration.

In the meantime, | got the image on my screen. Thanks to the
File Info, | checked to see if the resolution was coherent with
regard to the final printing dimensions. =

D.. the calilated soveen
s et (3 e
v 2] o A& TODDKE- hismisewse
E!dfiM’& i fl ) R[?B imﬂﬂe WLVWJ
vofile, | pretent the
vecinient with a '41’31’{,%1 eletn. He ov the
thast J&f;,r the tame inwdnrince

offered with & traditiowal

Jee Jeewd like

talsle. By

with its fowrce

rv'\ﬁ'ﬁ ot} Asv

f;‘tb iman
(chovthasd Lo !

e that |

ad the owe

eleta.

L — -
File Name : Prescilia.tif
Created :23/09/02 11:52:11
Modified : 23/09/02 11:52:13
Kind : TIFF
Width : 1880
Length : 2126
Mode :RGB
Resolution : 300.000000
Size :11.5M
Bits/pixel :8
Resolution X : 300.0
Resolution Y : 300.0
Units : inches
Software : Adobe Photoshop CS
. Date & Time :2002:09:23 11:52:11 .
| Color Space EXIF : not calibrated
Dimension X pixels : 1880
Dimension Y pixels :2126

When | opened the original file in RGB, a message appeared:

the image did not contain
the profile indicating the

source of the colors—for

Embedded Profile Mismatch

example, the photograph
lighting conditions (color
temperature). This is often
the case with files that
come from either a digital
camera or a scanner.

&/

The document’s embedded color profile does not match the current RGB working space.

How do you want to proceed?
) Don't Color Manage This Document
@ working RGB: ColorMatch R...

) Assign Profile: ~Adobe RGB (1998)

Cancel

()
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Light filtering L R
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weed Lo [te
A'n'jq&vew{;iw{;ed ltecome
inditbinct, fwih ad
the cace vf ltlond haiv
T A (VFiv me
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B As with photomontages, when-
ever you retouch a picture, the
outline remains the most critical
operation because the realism of
the result depends on it. Hair is
the most difficult. Fortunately, in
this case, the photograph was taken in a studio on a cyclo-
white backdrop (thanks, photographers!).

Whatever tool is used to preserve the outline, whether it's au-
tomatic or not, the principle remains the same: exploit a dif-
ference in color density between the areas that have to be
eliminated and those that will be kept. The photographic
method that was used well before digital technology existed
consisted of creating a “halftone mask” (sometimes called a
“fuzzy mask"). This was done by using different shades of gray,
thanks to either an alpha layer or to a layer mask that was al-
lotted to an overlay. This mask represents a memorized selec-
tion which acts like a “light filter”: every action is proportioned
according to the transparency of the mask.

Blue

A[-pl’/tfu 'r&'tf_lje"

Alpha 2

Lfoj ev
Moagle

Outline ]

lin onrv ALY, it wM o ve
A QCFWCWHZ {;«r vwf]{1wt RAIY Tiv MZV
FMB th.fv.m 1’,'17 vwf;(l»& naiv

%fvlw.ff w 15“’1’; WM""T’

Fin.
Mr:'z/g

12
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Splitting hair

Photoshop offers automated outline
functions (e.g., the Background Eraser
tool or the Extract function) which
obey the same principles as the masks
| described in Stage 3. These tools are
quite efficient if the documents you
are working on lend themselves to
such operations. However, the user
must also have enough knowledge to
master the tolerance parameters.

s 3 Eraser Tool E
? Background Eraser Tool Eg

J
= y Magic Eraser Tool E
a

The next step consisted of duplicating this layer
(creating an alpha layer mask) and increasing the
contrast to obtain black hair against a white back-
drop. However, it was also important to maintain
the different shades of gray so as to ensure the
transparency of the hair

When it comes to outlining hair, | pre-
fer to use the halftone mask method.
1 agree that it takes more time, but it
is much safer (i.e., more controllable)
You can use the Curves function to adjust the
contrast of the mask. You can also use the Burn
and Dodge tools for local finalization (lighter in
the light tones and darker in the dark tones).

To begin, | chose the most contrasted
RGB layer between the hair and the
zones that needed to be eliminated
(backdrop and face). In this case, it
was the Red layer (Cyan ink).

wal;w;w}j Hﬂf‘it t(ftf
E}ctﬁ’t{f fuu(f‘fvu

Rernlt oltained

;bzm.?».ft A goler

lackdvon

é"’\ Burn Tool 0,

Wa E .\ Dode Tool
—T_.

) S g Sponge Tool O

The difficulty lies in the (ad equate

adjustment of mask transparency.




Indeed, flaws stand out more against a dark
backdrop: "cobweb” effects appear. Here is a
trick that may help: apply an Inner Shadow
layer style to the layer containing the hair. Next,
make the proper adjustments individually

Be{-‘we: coltels e;’%f&(f

.

Alter having nsed
the fnner Ihfw‘lv'w

02 - b?gh‘;‘-ur L«Wj evyf

Stage.
Layer Style
% Inner Shadow
S Structure -
Blending Options: Custom Blend Mode: 1{;‘]1,9“. e : ,-
_| Drop Shadow Opacity: Oy, 75 %
™ Inner Shadow : |
Angle: 120 g Use Global Light
_! Outer Glow e
n ".”‘J—-———-———— {
Inner Glow et o px
hoke: Cym— %
_! Bevel and Emboss o &
SiZ8: Oy —— |G px

_! Contaur
_! Texture

or Overlay

Quality

Contour: __| Anti~aliased

To add hair outside of the framing, all you
have to do is Cut and Paste the locks.
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Stage.;

Surgery . ..

T e Here, It was necessary to
| Her back should . act in an audacious yet
rbe M smart manner: using my
| [Z]  mouse, | cut Prescilia in

half from the waist down
to her feet. | manually rotated the lower half as a
transformation, then | repositioned the image
based on the hollow of her waist.

B&:Fvv'e | T;VVC&M!M{ m]‘;h f}itﬁi

swrgical eeperi ot pued A

Ll o] £ ﬁ” e

a L 3*’“& il
I

! ed thomacn, |

e , &T b . ; i?' Vector paths worked well
ﬁm‘;!w( tne ontline "f e with this subject as they
[sody this wew poditivie. allowed me to use long,

flexible curves. However,
in spite of the elegance of
Prescilia’s forms, certain
positions had produced
unsightly lines. | took ad-
vantage of this phase to

modify the hollow at the
Vector paths worked well top of her thigh, gave a
to obtain long, flexible curves. rounder shape to her

knees, and brought a fin-
ishing touch to the new
curve between her belly
and the small of her back.

7 -
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—
i transformeq the‘vector Stage ;3
path selection into a
bitmap, then erased any-
thing that came over the
outline. Using the Clone
Stamp tool, | patched up
the internal surface by dab- :
bing layers of skin C0|él’. On The “ heallng erSh” tool is ideal for
her belly, where the rota- correcting spots and blemishes, dust,
tion was, | actually copied pixels of skin. Everything should have gone well if scratches, fines . . .
the reference area | chose had been judiciously selected. But, | was quickly
confronted with difficulties and ended up
with intolerable blemishes. . . .

In fact, this tool copies the texture only,
whereas the color is recalculated accord-
ing to both the pixels of origin and the en-
vironment being healed. It is the ideal tool
to correct blemishes, dust, scratches and
lines. Its “little brother,” the Patch tool,
acts the same way, but only on the sur-
face. All that has to be done is move a se-
' lection.

. (ﬁ Healing Brush Tool

{} Patch Tool

& W Color Replacement Tool

Luckily, Photoshop offers the Healing
Brush tool, which actually resembles the !
Clone Stamp tool a little.

--—

However, there remained a problem: it was
not easy to recopy
the shadow above
the navel, place it
where it should fit,
and give it the
right curve. To
solve this, | se-
lected the area
and used the
Liquify filter which
makes it possible
to distort an image
at a given place. A
grid was displayed
on the screen so
that | could control
the regularity of
the distortion. m

At this point, | had to se-

lect some skin area to
recopy it somewhere
else. At first, | was faced
with the same blem- -
ishes as before. How-
ever, when | released the button of the mouse, the
new pixels mixed in with the original pixels and took
the same color. Differences faded away even when
the color of the skin was either lighter or darker.
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Let’s bring in some color. ..

O Eloroann The lack of contrast in reds is
Improve detail of bikini: not a problem that started
we do not see the with digital technology. Re-
stitches enough. producing an image that con-
Get rid of transparency: ! tains a lot of red was already
we can see the bra cup. a problem photoengravers
Check color. were confronted with before

(absence of matter, lack of

[_ contours, and volume).

In printed quadrichromy, the reds are predominantly obtained
through Magenta and Yellow inks. Yellow is the color that is
seen as the most luminous. As for Magenta, it must be dense
in saturated reds (otherwise, it looks like it is orange). As a con-
sequence, two superimposed primary colors produce reds that
lack contrast. Therefore, these two primary colors are not the
ones we can count on to restore volumes.

Painters, At all times, lw;/e
wixed the colov ved wii:ftj the
colov vJ: leaves i *r:"'*!ijkft to.
vestove the green vg the J:v[-“mﬂb jin
the thade. This it wel 4 new
vecine: it il the com lewnentiry
cvlvr which it added tv vestvve
IWVNJ. Cjiwv Tia Hm& ru{.{,
Magenta in the qreen, Yellow

i the [tlued.

However, Cyan ink is too light to bring out contrasts
sufficiently, and that is why the reds look flat. A sepa-
ration table which allows the creation of a GCR black
makes it possible to improve the situation. By replacing
part of a complementary color (here, Cyan ink) with
some Black, the GCR partly compensates for the lack
of contrast.

Alter

On the RGB image, however, it is possible to anticipate the
problem before the CMYK separation. All that needs to be
done is to accentuate the contrast of each layer, in partic-
ular that of the Magenta and Yellow (on the Green and Blue
layers).
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Stage.

The objective was to take \a AVANTAZE of the contrast of the

el

The first solution consisted of accentuating the de-
tails of the Cyan ink by increasing the contrast of the
halftones on the Red layer. This was done by work-
ng on the middle of the curve. Then, | opened the
layer Mixer and selected the Green layer. | mixed in
some of the Red layer (Red cursor) to this Green
layer, which had some shades of gray in it. | contin-
ued the operation by selecting the Blue layer. The
objective was to take advantage of the contrast of
the Red layer and introduce a share of that same
contrast in the other layers.

Output Channel:
Source Channels

Red:

Ch

Green

C
ed layer and introduce a share of

that same contrast in the other layers.

o |
L;Lvefw!: f;ite (v!w’ 0{ the
fﬁfz_?w? WAL mvﬁ{;g;'et’f.

!
AJ’ A (onfEqmnenle, | 'ft[td f?v

,'uﬂ‘-!u,ji' ;i' fé‘j ‘MZ’[;L«H

chromatic covvectivid.

Channel

annel Mixer

]

<

With this second method, one works on
brightness alone, and does not depend on the
chrominance.

+186 %

o
)
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New skin

It is hard to make skin
color even. One method
consists of working in Lab
mode. CIE Lab is a mathe-
matical model of color rep-
resentation that is based
on visual perception. The
color can be described in
various ways: in RGB by
adding light, in CMY by
mixing different matters
(inks, toners, etc.), or in

darker red).

HSB—Hue (the color itself: e
Cancel
red, in this case), Satura- —_—
tion (concept of purity: E) T EroTre——
sharp or dull red), and i S S
Brightness (brighter or | @u: 22 1° O [70
s Os: |47 |% Oa: |19
OB |77 Ob: |26
TJR: 196 c:l20 %
JG: |138 M: 43 %
OB (104 v:[49 |x%
# [C48A69 Kl %

L .

Layer L (luminance) represents the contours and the matter
(it is the image seen in black and white), and layers a and b
describe the chrominance, that is to say, the color itself, the
combination of Hue and Saturation. Therefore, having the im-
age in Lab mode makes it possible to work on the luminance
on layer L and on chrominance on the layers a and b, inde-
pendently.

Creating artificial skin

| converted the RGB image into Lab mode and duplicated the
averlay of Prescilia with her mask.  finished the outline so as
to keep skin
surface only

l L
Wnlile Lake mode, these trres

odes Aepend o veproAmctivn

conditiond. Al n coniegntn(l; ;
|

iCAd ¢ ExAL

cﬂl-er ffc' (vmt:&w»»j(:”u:fe. t}: {%7; {:Y
VEA [v[vv’ 0'1: fne- [J‘E‘i‘w’! nA ; . v
6767;#‘5,” 7{7 e f—;’vﬂf} v,’&lw&r. This

[, J’ p
#fvwe (v/vr’f wad {Tﬂrt’;w r\m«erbw’

;wfv Rcr.B oV (:I\/lel-/- .’»C(v-lfﬁhuﬂfj.

1

_Layers | Channels ™ Path
= i
- Lab
| recorded the gray - L |
values on the layers a
and b of the sample — AR ‘
color that | had re- - i a 429% Gray
quested. = R LR
= b 40% Gray
. .
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Cranmas [ | selected the silhouette and filled the
. Iayer a with 42% of gray and layer b Stage

b with 40% of gray. By visualizing a +

L b, I had a uniform chrominance on the

totality of the skin.

| »
Layers Channels Paths {i ;‘

Normal } :] Opacity: |75 E]

Lock Elj"l“i_ Fill: [100%

= ; @ ¥ ﬂ j'. i | Curves E

=

- s o
Once layer L had been selected, | cor- ~
rected, in black and white, the con- L“‘ : ik =7 b Sy
trast, spots, and blemishes A | Rz o
independently of the color. | adjusted v
the tan, the grain of the skin, etc. J w -l
L _ b L By making a and b brighter, the tan got
Curves - redder and the skin yellower. The curve
Channel: L 0 \ r T ' that | used was stored on an adjustment
- "l\.\ L layer and mixed together with the preced-
¥ . ing one.
| .
e | However, Prescilia and her new skin looked like a “Barbie doll”.
T === She did not look real. It was therefore necessary to bring the
i P P opacity of the New Skin overlay to 75% in order to take 25%
= of the original color. Blend

modes—provide the user
with various pixel combi-
nations between two
overlays (natural skin and
— artificial skin).
Layers . Channels = Layers . Channels
LI L= o= By o = : == Other things can be tested
wo D FF[A] oo oo (O] 7+ @ x 100 106 : 2

; ’ too: Linear Burn (white
skin), Overlay (light tan)
and Multiply (dark tan).

That was it: | had met the
photographers’ demands!
However, this type of
work is never quite fin-
ished . ..

——
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ERIC MAHE

Hardware used
= Contax G1 with a 2/45 objective

_ /
" Digta Casio V3500 EX ,Lz;‘t/u& ﬁ EViavovin

= Coolscan IV scanner to 2950 dpi

2 Tiv NV{tj B(J;

Software used
= Photoshop 6

he original photography was taken in the port of Nosy Be, F?‘w/v/ !m‘;"j&
a small island northwest of Madagascar. This late

afternoon, during the rainy season, lent itself perfectly to an

active walk, at least as far as photography was concerned. With

my Contax camera, loaded with a TMAX 400 film, | had

everything | needed for optimal comfort and great shots. | was

standing at a crossroads, and was more preoccupied with | always thought that a good (PhOtOgraPh consisted of

keeping my feet dry and avoiding mud puddles than thinking 80% frarting..10% technique and 10% chance.

of what was happening around me. | suddenly caught sight of

the 4L which was coming from my left and of the little girl who

was trying to cross the street on the right. | “shot” almost

instinctively and simply hoped that the composition would take

shape spontaneously. As the contact-sheet showed later on,

that was the case indeed, thanks to the presence of the young

boy who moves away from behind.

29
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Staqe | .

Taking a first look at the shot This electrvic wive

f
Unfortunately, if the composition of the photography functions ’{V&f ol IVVK VﬁVj : p
as a whole, the corrections that need to be made are likely nu- wice. ' The J'[L.J il
merous. First, the main protagonist, the little girl, is lost in the e foo-
uniformity of the ensemble. This fact is reinforced by the posi- ; J |
tion of her face, which is located at the bottom of the image / bﬂjf"«f-

and which, as a consequence,
must be sought in order to be
seen. In addition, the sky is so
light that it is all that we can see,

and, hence, it keeps us further v
away from the principal subject
of the picture. The little girl’s
face is also too close to the right
wing of the car and it “blends”
in too much. As for the electric
wire, it does not serve any pur-
pose. This gives us a list of the
final improvements that need to
be made in order to give an
artistic touch to what the cir-
cumstances were kind enough
to “offer” us.

The vi Hnﬁe
lacles contrat.

Retouching work
plan ;
The cav if wotl

The logical way to look at a pho-
tograph is from top to bottom.
Therefore, | retouched it the
same way. First of all, the sky
needed some “filling in,” so as
to rebalance the entire picture.
Next, | concentrated on the por-
tion of the photograph that in-
cludes the car and houses of the
village. Finally, | worked on the
luminosity of the little girl's face

so that it would have the place

The Little i vl's
[ Ao ol
(M& (A

it deserved. Following this order J'ﬁfw»ﬁ{ gt
in the management of the re- e ;
touching process allowed me to ""--».-\_,__M &wwj] n.
gradually rebalance the composition as a whole. = S

30
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Stage 4 |

Removing the
Malagasy sky

A white sky, without the slightest
cloud, is a nightmare for all pho-
tographers. Indeed, it requires
delicate work in order to be arti-
ficially enhanced by hand under
an enlarger. This prevents the eye
from getting lost in some irrele-
vant part of the photograph.
Moreover, it is only after the pic-
ture has been developed (and it tion, | included the antenna
often takes several fruitless trials), e that | wanted to remove, as
that it is possible to measure the well as the wires
weight of such a bland sky. that were attached
to it. A 3 pixel
feather, as well as a
5 pixel smoothing,
gave me the perfect
selection. The Erase
control of the Edit
menu allowed me
to make room for
the new sky.

Lasso with the Subtract op-
tion, so as not to erase bits of
roofs unnecessarily. Then, us-
ing the Rectangular Marguee
tool along with the Add op-

Photoshop allowed us to check whether the over-exposure
might have burned some clouds. We can check this by push-
ing the gamma a little. Unfortunately, the result looked too
“dirty,” with a grain that diminished the
guality of the image. Conseguently, this
entire piece of sky had to disappear and
be replaced by
clouds that came
from somewhere
else, as we shall
see in the follow-
ing stage.

First of all, in order to remove the sky,
the background had to be copied onto a
new layer so that | could move it around.
The next step consisted of selecting the
sky. Making use of the Magic Wand
seemed quite appropriate here, with a
basic tolerance of 32. The result was not
perfect (it never is), but Photoshop pro-
vided me with all the tools | needed to
make things better. First of all, | used the
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Clouds made 1n
the USA

It happened that, during my last stay in
Las Vegas, | had taken a beautiful shot
of some stratocumulus clouds with my
digital camera. The idea of mixing the
two technologies was appealing to me.
Indeed, it was quite a challenge to try
to perfect this composition by reuniting
elements that were, initially, some
9,000 miles apart.

& 10060048 1IF @ 33.3% (Gus)

However, | had to make some changes
in order to properly integrate this piece

" pﬂ;;’t'({—i wy

faa
the images

of American sky. Because the photo-

graph of the clouds was in color, it had to be converted to
black and white to fit in with the initial photograph (I used the
Image> Mode-= Grayscale control). The Levels control enabled
me to give the clouds a tonality that corresponded better to a
Malagasy light. The only manipulation | had to do was a drag-
and-drop of the cloud layer in the photograph and then invert
the layout of the layer. | was almost there.

It happened that, during my last (Sta)/ in Las Vegas, | had
taken a beautiful shot of some
stratocumulus clouds.

M

| say almost because
the dimensions of g
the clouds did not
quite correspond to
those of the sky that
needed to be re-
placed. Once again, |
had to select the im-
age of the clouds
and, in the Edit menu, use the Transform menu
item. Once the two overlays were active again, the
manual removal of the clouds made it possible to
fit them inside the photograph.




Stage X .

Caution: school

It was now necessary to separate the corrections that were go-
Ing to be made on the village/car unit from those concerning
the little girl. As a consequence, this step consisted of select-

Po £ jroge inver Ieec MRz fow Wrdew tee

ing her face in order to isolate it from the back-
ground of the image. Later on, | used this
selection in order to remove it from the rest of the
photograph. When using Photoshop, it is often
easier to isolate a minimal portion of an image
and remove it from a broader ensemble than the
opposite. In regard to selecting, simplicity is often
synonymous with effectiveness.

To do so, | created a copy of the image as it was.
| had to do some “work” on it, in order to make
the outline of the face easier.

Ngv_f( _— __’."/>_

the copsf
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In regard to selecting, ( S| m Pl 'Clty is often
synonymous with effectiveness.

The first thing | had to do was modify the contrast and
brightness of the image | had duplicated in order for the lit-
tle girl’s face to stand out as much as possible against the
background. Then, | used the Magnetic Lasso tool with 2
pixel-width options, and a 2% edge contrast. This allows
Photoshop to stick to the difference in lJuminosity between
the edges. A 30-point frequency made it possible to obtain
sufficient antialiasing to give a realistic selection to the face.
| added an extra 5 pixels to the selection that | had obtained,
saved it in an alpha layer that | then transferred to the main
picture. | could now close the duplicated image. =

e_oi_V3psd @ 156X (Calque 0.Guz)
— 4
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A profitable operation

Let's not forget that the final objective of this
work was to make the little girl’s face stand out
from the rest of the photograph. Therefore, in
order to achieve this goal, | used the tool that
has made Photoshop indispensable in the field
of retouching: calculations.

The first manipulation consisted of memarizing
the selection that dealt with the village in an al-
pha layer. The next step was to call in the Cal-
culations control from the Image menu. |
achieved my objective thanks to the selection
of the right options (referring to the two alpha
layers, working in the Difference mode results
in the form of selection). The little girl’s face re-
ally stood out from the rest of the photograph.
It was magical!

@ fille_on_V3.psd @ 15.6% [Calque 0.Gnz)

[Calque 0.Griz)

Source 1. | agiri_ori_v3psa =
Laver- [fusin =

Cramel. [Viage =] I ent

Sogce2: [ agri_or_Vipsd =

Lgyer: | fsion -

Charel [ gr1 <] ot

genong: [Drerece =]
oy [l =

™ Mask

Resut: [ Selection -

Now, | had to modify the contrast and scales of the village/car unit in
order to adjust them and match them with the face of the little girl. |
took advantage of
this process to rectify

Since the selection | had made beforehand (prOtECted it,

a small detail: the
hubcap prevented
me from enhancing
her face as much as |
wanted too.

| erased the hubcap by
dabbing it out. Safe and simple.
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I also chose Stage.ls

to lower the clouds (C‘OUdS down just a few millimeters,
50 as to stress the higher part of the sky.

e ER lmage Layer Sekect Filler Vew Window Uep

Since the selection | had made beforehand protected it, | erased
the hubcap by dabbing it out. Simple and safe. ~
The final touch

The last thing | had to do was to call in the "Girl” se-
lection from the alpha layer and use Levels to adjust the
brightness of the face. | also chose to lower the clouds
down just a few millimeters, so as to stress the higher
part of the sky. Here again, it is a matter of personal
choice.

-ﬁé
ool
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VINCENT RISACHER

Hardware used

= Rotary scanner Dainippon Screen SDR 1045 Al
= Macintosh G4 :

« 1 GB of RAM
=« 100 GB hard disk

Software used
» Photoshop CS

Final | mate

ommunication agencies often work on both exciting and
surprising projects. The flyer that is presented here is a
faithful replica of what can be achieved when working on the
restoration and touching up of images—in this case, a person’s
face and a background that needs to be amalgamated. .
It was essential to understand the customer’s priorities from Touching up the face.(pla)” ng with various colarizations,
the beginning, in order to meet his demands without taking the die was cast . . .
anything away from the initial idea. Now that | was in control
of the keyboard, and backed up by the artistic director, | had
to do my best to respect the photographic intent while pro-
posing improvements and modifications which corroborated
the agency’s request
Touching up the face, playing with various colorizations, the
die was cast . . .

Q2
™~
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Conversion

Before working on the various phases of col-
orization, the color picture had to be con-
verted into different scales of gray. There were
several solutions that | could use.

| started with the :FMf;Mf:
folntiow: lmage~ Md z—»4mﬂ,rml-e.

That Aid ot covvespond at all

w'i{:}’t f;l{w Ajwﬁmiﬁ v{: A trne

[4[-:1{1':4 fwﬁ‘! wl{ﬂ'f;& pictwre!

| then chose what seemed to me
the most appropriate solution: use
the Image—»Adjustments>Channel
Mixer control. However, instead of
doing this directly on the picture, it
is always preferable to remain as
flexible as possible and therefore
use an adjustment layer. Once the
dialog was displayed, | checked the
Monochrome box and made the
necessary adjustments basing my-
self with Photoshop: R=55, G=45

Y
&

TSR |

I ST IS

m‘;h -

Couche de sartie

Cauches sources

and B=10. | always remember that pre-adjustment files are kept in the
Goodies file of the Photoshop CD-ROM. | clicked on the Load button,

and got to the file | needed. | loaded some files
initial adjustments.

and came back to my

-« =@
15 Agobe Reaser 6.0
Agobe 5 5 Network
F Adobedi . opiR) CS
L/ Googies
Heip

Grayscale

L/ Crannel _rPresers »
Custom _fo Paneis
¥ Res RGB Textures
fynda.co. . swatches
Optional Plug-ns
Seripting Cusde
Stock Art
SVC Viewer

Special Effects
YCC Color

Support _ gistrat

Cancel

2 CMYK to Gray.cha

£ tosd )

38

With an approximate 10% modification for each channel, the
result is, very often, quite satisfactory. In order to finish ad-
justing the picture, | used another adjustment layer, but this
time it was Curves. Thanks to the black and white levers, |
placed the extreme values of this picture at 4% and 97%.

051
=1
Discard color information? =

(_Cancel_

— Don't show again

It seemed to me that | had to slightly modify the curve
in order to improve the contrast. Now that that was
done, the picture was properly converted. Since |
used Adjustment Layers during this conversion, it
would be much easier to make corrections later on,
if needed.

7] Visoge id @ 10UN Courbes & Masque ¢ fusion
¥ 13 R

L
Levets.
= Awto Leveis
Auto Comtrast

Hue/Saturation
| Dessurae

Replace Color
Seiecuve Color
Rute
Options..
| _Ed

F prerrew

XoRL

Colar Balance. *

Brghiness /Contrast

sAA

=L
oxL

xu
axu
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Surface retouching

The next stage consisted of surface retouching. A quick
glance at the model’s face revealed areas of the face that
did not show any details. Moreover, | felt | also had to
touch up some other areas of the picture.

One big plus that Photoshop provides the user with is the
Healing Brush tool. Quite similar to the Clone Stamp tool,
it offers many advantages and is easier to use. It should
almost be named the Smart Stamp tool. By Alt-clicking on
a neighboring area to set the origin of the overlay, | cre-

ated the illusion of
skin on the hotspot
of the forehead with
very little help. | then
repeated the opera-
tion on one of the
young woman's
cheekbones. Next,
| switched to the
Clone Stamp tool
to erase the beauty
spot on her shoulder
and the grains of
sand along her arm.
Finally, | used the
Healing Brush tool
again to correct any

rl

& Photoshop fie EOR image Liyer Seiect Filer Vil Window HelD

v 2 e B e @t O+ i

I
o 4

ot

L 2:1:]

Wintonched i wmage

All | had to do now was work on sharpness. In
order to preserve the softness of the grain of
the skin as best as | could, | duplicated the im-
age onto another layer. Then, activating the
Background layer, | applied the Sharpen»
Sharpen More filter. All that was left to do was
to create a mask on the duplicated copy, then
play with the Airbrush tool. By giving it a 70%

skin irregularities that | could see: the small opacity and a black

lines under her eyes, nose, and mouth. e e foreground, | could
P T e o) ]

At a whole, the vetlt covverponds
to ey wbj%ﬁve, which i ‘fv
prefevve a I!‘I—pr pfcﬁwve M'Hurwi:

' wmplifing ov wmodifying the
vﬁj?wﬁvl jrﬁﬁu Vf f;ﬁw pk’tvi'ojvwr;h

Aasnd J'[ﬁu—.

choose both the in-
tensity and area
where | wanted to ap-
ply the filter: eyes,
eyebrows, a specific
part of the mouth and
hair.
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Retouching the density of the picture

In order to properly carry out my work, | merged the duplicated
layer with that of the Background. Then | used the Burn and

Dodge tools to retouch the picture.

& Photoshop File Edit Image Layer Select Filter View Window Hel

q.! wrush G-s-? tange: “Mdtones 18] £x

These tovls come with tome fuwwj navameler].

Used ags H»ej Ave, Hvej 7 owv/j riin the picture, st
ltecasse theiv navaimelers have values that ave i Lo .rfm..j.

Al a Cornlqmneine, 2':;1—& ﬁm’f; 1';?’1'1'»3 Hw wiery wmndt aveid Avi»j if

bo have a vesult that it m/wlj Ltm'jltt v, vie the wwi'rmrj,

vv&wfj Aavle. That is wltj | 4id wot hesitate to veduce the
expolnre vativ b\'f lf% and WVVL’(F;A vie t'r,te midtoned.

To begin with, | used the Dodge tool in order to unify the light
around the face, nose, and roots of the hair. | also sharpened
the intensity of the look by clearing up the white of her eyes.

Then, thanks to the Burn tool
and a rather small brush, | un-
derlined the contour of her
eyes, eyebrows, and mouth.
The next step consisted of re-
balancing the lights of her ear,
then with a much larger brush,
| gave her hair and hand the fi-
nal touch by making them
slightly darker. A few years ago,
this type of retouching was
done with a brush and a chem-
ical called ferricyanide. It re-
quired as much expertise and
delicacy as the Photoshop tools
today: it is thus strongly recom-
mended to have both fingers
close 1o the Apple/Ctri+Z keys!
Compared with the original pic-
ture, this one has gained in
contrast and punch. =

1§ —

afi~:8

Y & rPhotoshop File Edit Image Layer Select Filter View

rarge " Mudiones. -B Exposura: [13% B A

LX)

] Visage.psd @ 100% (Arriere-plan, RVB#)
T 3

T
Exparare: (1% [0 A
- 18686 T Visage psd @ JOO% & )

| Image Select Filter View Window Help

o tousay  NEW > a \_,,.
Duplicate Layer.. = i
Delete P Kot | el o
Layer Properties... —_— 3 oo S E‘
Layer Style » glotrla) o iy

New Fill Layer P E
New Adjustment Layer > |

New Layer Based Slice

Add Layer Mask »

& = |

Add Vector Mask »

Create Clipping Mask

Merge Down

(v'l Photoshop File Edit Image Layer Select Filter View Window §
LI |

Range Miores (8] Expunene [0 8]

BE g Cuer c LN a0
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Last preparations before colorization

04 —Beasnty lnstitt I

In order to prepare the various assembly L pe—

phases, | opened a new document and gave it
the same dimensions as the ¥
flyer. Once | had created a L
group of overlays in the
Layers palette, | clicked on
the picture of the young
==} | woman. | bound all the
overlays and, with the

Move tool, | moved them toward the group of -
layers that | had created beforehand. L

Once all the layers had been incorporated into
the group, | joined the adjustment layers,
along with the picture of the young woman
by using the Layer> 3

Merge Layers com- (I o n—
mand. Then, | placed

the points of refer-
ence which, by de-

fault, snap to the = =0
correct position. This e
enabled me to easily = |
position the pictures. -z

To obtain the four pic-
tures | needed, | dupli-
cated the group of
initial layers three
times. | simply re-

| now had to pick the colorization
color | wanted. | chose an “orangey”
shade. However, | decided to “treat”
' myself and skimmed through a range
of different orangey shades which
varied according to their Hue, Satura-
tion, and Brightness. After having
created a new document and filling
it with the original orange color, |
chose the Image>Adjustments >
Variations command which enabled

- b s e i1}

named them: Top "

Right and Top Left,

Bottom Right and Bottom Left. With the Move tool, | arranged
the four images into the montage.

| always name and arrange my |a>/e rs carefully in the event that
someone else might have to work on them.

me to go through all the different
shades in no time at all. | clicked a few

times here and there in order to give the shade | had se-
lected a redder and brighter touch. | clicked OK to con-

firm these

modifications. With the Eyedropper tool, |

removed this new orangey color from the document and
declared it as my foreground color. Since | did not need
this document any longer, | closed it. m

& Photoshop File Som Mnage Layer Select Futer View Window Help

N e

G e o G [ T
‘3!9 L. i RN YaE ‘

=
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Colorization o
Norma 19 ovecc [l [ A\
There are several ways of colorizing ok QiFF0]  efE® -,

[» G sottom mighe

a picture with Photoshop. Different
commands can be requested: Duo-
tone, Color Balance, and even Vari-
ations. Here, | chose to use the Hue/
Saturation command because it
offers, in a single dialog window, all
the parameters which define a color:
hue, saturation, and brightness.

-_Ta-iﬁoﬁ“mm 1 ﬁ__ Photoshop File Edit Image Layer Selfct Filter View  Window Help _T

(A sveonsor i)

aEsi m e

P ——— =
’ 7> Fiyer @ 33,3% (Teinte/Saturation Iasquﬁdehu |
¥ =]

FiRE
NAT|

Qe
Wy

'“l‘b.' l‘ a
- AT

il L)
WA

Channel Mixer...
Gradient Map...
Photo Filter...

&
12

@

Invert
- Threshold...
@ Photoshop File Edit Image Layer Select Filter View

|G e —

i

g 1 O O % Flyer @ 33.3% (Teinte/Saturation 1, Masque de fus
e | R TR SPT L < T
i
() |
g — Eod
LB, A i
£ ) Hcolorize  [|F B
I JEJ ZIZZ] Hresen | ]
i) — H 1
— ,“‘ | | B hgrmes ﬂ:
o e === Fiegiaielisls
&[T]
B
)
|
[ § By default, the colorization color that was suggested was that
= ; :
ca’ of the foreground. In the preceding stage, it was necessary to
[FET

define this color as the foreground color. Hence, in order to
simulate a colorization which was to resemble a print made on
white paper with color ink, | inserted a +50 brightness value
and confirmed by clicking OK.

Colorization isa sus f making thi beautiful.
Having made sure | had renamed each overlay group, | created = e - auu_
. . e Beyond the redlity of the picture, it allows for the creation
a Hue/Saturation adjustment layer inside the Top Left overlay d ;
group. Once the command was displayed, | validated it with- of a world based on the atmosphere that derives from it
out touching anything and then moved it to the top of the

group. | double-clicked in this layer in order to display the dia-
log box and checked the Colorize box.

- 7 N—
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& Photoshop File Edit Image Layer Select Filter View Window Help

)= Fiyer @ 33.3% (Tewnte/Saturation 2, Masque de fus
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With regard to the picture situated in the Bottom Right
group, | proceeded the same way, but with a 0 luminosity
value. This is the most common colorization: the result re-
sembles a print that has been made on white paper, with
black and colored ink.

As for the last picture inside the Bottom Left group, | chose
another means of colorization. | picked a new Solid Color Fill

Load. o —— 3 ;
e C=> H ¢ #] el Layer and placed it over the other adjustment layers of that
i =] | same group. To activate the colorization process, | switched
e p— g@*«_m = e u from Normal blend mode to Color mode. A slight modifica-
= [ | tion of opacity enabled me to obtain a uniform result in color
- e saturation. =
| proceeded the same way with the Top
Right layer group. | used a similar ad-
justment layer but with a different type
of colorization, the type that simulated
a print on colored paper, with black o5 Wie EGW_Tmage Layer Select FMer View Window Help
: b B L amsdeciaver Sostomamgie | Taelis B3 | TS pealdd |_§ E
ink. In order to do that, | checked the L —— =
Colorize box and inserted a —50 bright- &~ io 8 B e L M e e aa e
ness value. p! 1;};‘%‘%i
This working method allows for col- ‘i’;;‘ - .
orization of straight-line type docu- Bk et
ments, without having to resort to ;:91‘: Z
selections. In order to directly colorize DB |
the black straight line without modify- CIFd
A 1 : VIEY R Gradient...
ing the white area, it was necessary to ~— _ Pamemn.. [
adjust the brightness value to + 50 and E = , gy
play with hue and saturation. On the e} —— Color Balance...
her hand, in order to colorize the [ SRS
ot Ver nd, In o'r er g o l “  Hue/Saturation...
white zone, the brightness value had to Sebshs ot
Channel Mixer...
be set to -50. In both cases, the user B[ ol
. - b Yot Photo Filter...
must check the Colorize box before- e
. Perer= invert
hand. l Threshold...
- mdge  Posterize...
9.0 5 mareveny

Doc 5 5504/ B4 ¥l -
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Chromatic retouching

All the pictures now were coherent but still required some re-
fining. Each picture was the result of a Color Balance, Curves,
and Hue/Saturation adjustment.

| worked on improving and standardizing both the brightness
and contrast of each picture. To do so, | double-clicked on each
Curves adjustment layer and modified each curve repeatedly.

Flyer.psd @ 33,3% (Courbes 1, Masque de fusion) jges

E . F ... E...P Tl Layers  Channels Tpmhs |

| U O O

Curves. Curves

Channet 03 ) == Channet RGB_ 18) =

I 1 £ 3 (Oprions... ) 470_2_0
E FI7A |
E W Preview
T
Input: 25 - |
Mpul-]_s- .‘) S |
Curves = = = i
Channel: RCB 5 @ b
L . )
4‘/
2
[
S == Each adjustment layer came with a mask
ms Z77

Output-[51 |

which enabled me to reduce the intensity

Substantial (CO I‘FECtIOﬂ S are made in order to better
enhance the lights and contrasts of each picture.

Vistualizi g Hw VAaVivd
covvectiom p;bﬁ.d' ed.

of the color (Dodge or Burn). | selected the

W8 8 e e
i

Airbrush tool to work on the corrections |
had to make and gave it an 80% flow parame-
ter. Since this tool is flexible and sufficiently dif-
fuse, it allows for simple and quick corrections
while keeping the user in a photographer-like
frame of mind.

For each image, | made substantial corrections
in order to improve the lighting and contrast of
each one. Again, | revised each adjustment layer
mask. =
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The Grand Finale

The last action to be performed consisted of placing the picture of the sea-
side within the montage, then typing and positioning the text. Once | had
opened that picture, | slipped it inside the montage thanks to the Move tool.
Once that was done, | simply laid out the copy of the seaside over the Back-

ground layer. | would come back to it a little later.

Next, | typed in the caption and positioned it. | also used the Character
pa!ette to modlfy spacing as well as the vertical scale. | justified the entire
line. | placed this copy of the text over the last
group of overlays and clicked on Layer Styles. |

decided that | wanted to cumulate various effects:
Drop Shadow, Outer Glow, Bevel and Emboss,
and others. Now, | could concentrate on the sea-

Levels =L
Auto Contrast X O'%L
£

Curves
Color Baiance xB
Brightness/Contrast...

side.

In order to attenuate the excessive sat-
uration of the picture, | created a Curves
Adjustment Layer and lowered the ex-
treme value of the black point to a value
roughly reaching 30%.

FH o 2l e s W) s

& Photoshop File Edit Image Layer Select

]

Filter View Window Heip

B CIE

$

(o] -] Fiyer.psd @ 42 8% (PARIS, RvE)
s s E

Fi

Glulel” | c R[N R0

Bl Y, |
‘gEui!w,"_t._—i_ﬁ_i._w'_\_/
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2L & Photoshop File Edit image Layer Select  Filter View

aY T SowNSo

Finally, in order to modulate the whole picture, | used the Re-
flected Gradient tool (under Gradient Tool) with a modification

of the Drawing mode (I switched from Normal to Multiply
mode). That gave me the possibility of adding two or more
gradations, instead of replacing them little by little. | chose to
apply two gradations: one between the top and bottom pic-
tures, the other at the base of the text so as to make it more
legible. The retouching phase was now over. Since this was
done thanks to overlays, the customer could add corrections as

he saw fit without any difficulty. =

il



Sejouﬂ. itr techwical interest,
nfws‘wnw Vilivie 1,{, rv-y' me, A J'n.’b(&
évV expredlivis. [[ f»wge fmfmwt nmwﬁj
;qftmct the eye waumre vf theiv rize,
it JMf‘J‘ vr‘fﬁw 6»»(,’»*»&%1]6 ]frta v;#.r&rver

to mm ﬁfw 1mf1ge. Thasles to this

wv;’fé,f(bvn,, { wpe Lo 311/8 veaders tne

Aesive to nse the tools | wsed to

enhasce theiv madlerpiecel evew move.
Retvw(}’ﬁp‘.j 18 Wt adwin ! meant tv
Impreve A w fjh—w‘b wad t/’j Avine tv
;4&}11“ w1ﬁr¢, ?t iJ [v[.rv ;t/f .v!va /Upu,j‘f«,/
Lo ne/;«, veach move creative hovizond.



in luck. You may be
some of these steps!

n behind the scenes.

Hardware used
= Room Sinar P2 4x5 inches
« Plans films - Black and White
= Macintosh G4
=« 256 MB of RAM
= 20 GB hard disk

Software used
= Photoshop 7

AJ' Jem {4/1 wj
Hte Ipiw'to:f

s an independent photographer, | was converted very early

to digital technologies. Sometimes, colleagues call me
and ask to carry out some digital manipulation on images they
have taken. -

In this particular case, | had to work on a rather imposing
project: the print of a sail-making workshop. Three consecutive
negatives of the workshop had to make up one single pan
shot to decorate a stand during the Paris Boat Show. The final
version was to be a 4 X 13 feet print! The API Studio, located
in Larmor-Plage (Morbihan), France, specializes in advertising

FRANCOIS QUINIO

fvw/ C!ivVv’(&!

lmages [ilced tog ether

photography. Once APl had taken the pictures and examined
the specificity of what had to be done, they entrusted me with
the responsibility of regrouping the three photographs into one
single image

One ( p r l’]t, made out of three negatives,

was to constitute a pan shot for a stand
during the Paris Boat Show.

fwilt, Pevspectives,

47
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Pre-visualization

The photographer’s objective was to emphasize the horizontal
plane of the floor and the movement of the fabric. The various
distances between the foreground (2.6 ft.) and the far end of
the workshop (65.5
ft.) forced him to
resort to the rules of
hyper-focalization and
of Schleimpflug tech-
nique. It was thus es-
sential to use a large
format camera here.

| set up the view camera so that the nodal point of the lens
was superimposed with the rotation axis of ‘the ball-and-
socket joint. If levels are perfectly regulated, the view camera
ensures the faithful reproduction of shifts, rises, and falls. This
makes framing possible.

Fivet analysis: the
Tl B t-hed 1
Ao o1 H&& ‘Pv[fwmtf
EVWﬁVUfJ wid to
checle i.f | had p/&wij

af vv'erme'f .

1 !
O

el

In addition to the fact that it was impossible to ask the
workers to stop their activities while the photographer
was shooting, two other elements hindered the process:
the combination of optical aberrations due to a diving
wide angle shot, and rotational movements. On one
hand, a 4”x 5" view camera makes things easier from
a technical point of view and allows one to take a per-
fect picture. On the other hand, it alters what is required
to properly link up images.

This gives me the opportunity to remind the reader of
some precautions that need to be taken during the link-
ing process. Each lens has its own distortions (barrel dis-
tortion, for example), which can be measured on the
edges of the optics more particularly. That is why the
wider the covering (between 20% and 30% minimum),
the easier it will be to link up the images.

’ ! . L fe FIPIOE (T
NUH.L‘ ?:L“W‘L Rvit,.t[t‘cw vh"[.t-,‘ Axaf
2

\/:?J\;—.ﬁ pvlJ.nI]
Ayl Overhead

Yes, | 4id!

V';&W

RL"EL:'l [L:t'u

Although this might look easy enough to do, it is quite tech-
nical. For the time being, the continuity of the pan shot must
be put to one side a little. As planned, it is necessary to mod-
ify perspectives and to rectify some parts of the images.
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In the top left corner of
the screen, it is possible to
pre-define the adjustment

h_{. 'l # Auto Select Layer

@ Photoshop File

' Show Bounding Box

Edit Image

. . | o
()~ Y x 4 o e . 1 | g Move + frame *
()lt,dnl/.ln&_, the work tools. This is very useful in = :' 4
s . 1 + Move without frame
The structure of this example results from personal experiences: order to define the size of | gE—

the brush, its opacity, its |
mode, or even the flow of =
the instruments that are
used for retouching (History
Brush, Clone Stamp, etc.).

for each project, | am used to creating three files which corre-
spond to the major chronological phases of my work. Here, |
have named them “sources,” “work,” and “ultim” respectively.

| ¥ Current Tool Only

PEMYIE

Explorateut de hchers —1 The quick construction of a “model,” in low
definition (72 dpi), enabled me to pre-
visualize the final image, thus giving me an
idea of what had to be done to bring this
work to a successful conclusion. 1 also used
this model as a guide for the final job in
;i high resolution. This means of preliminary re-
search guarantees the technical, artistic and
commercial success of the project. The three

main retouching phases showed on the

afs ) . b
J’{TV""I’.’{'/L-W"E' (v'»—»/‘f'?\)'m-j {.‘JE'AAA/Tvr. 80e

(: !&fu’ J'fvurf,urej e»,’o!’d!e

T . | .
ef;.f»ecfn ve [tehanior.

Photoshop meets this concern for organi-
zation rather well. Thanks to its File Ex-
plorer it is easier to see how a project is

moving ahead. The information concerning Cesoiuson - 305 595853 :
a selected file, the pre-visualization, and m{‘sﬂm é::: model. | lnamed Tenk e Fing he e,
the tree structure are visible simultane- Rl s - s and the linking-up process.

ously.

The original negatives were traditional black and white pictures
(4" X 5"). This made it possible to obtain excellent definition
quality. Their digitalization in a 5132 X 4005 pixel file format
was sufficient for a large format, inkjet print.

Woevici wi Aven

In order to move and dis-
tort file perspective better,
| envisioned a broader and
higher working area than
that. Starting with image
1a, | went to the Image—»
Canvas Size of the working
image and modified its di-
mensions. | made it wider
so it would fit in the three distributed images, and | made it
higher to give myself a big enough margin.

49
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Setting up the decor

For the final pan shot in high definition, | proceeded the same
way as for the model: the manipulations were identical. | gath-
ered the three source images (one per copy) in the same file.

Before going any further, | quickly checked the Levels of each
image in order to evaluate their contrast and density compat-
ibility in case | had to make any corrections. Everything was
fine! The Levels were coherent.

Channel. Gray

Input Levels: 0

Options.

FiVdVd

& Previen

To link up the three elements of the pan shot, | needed to
superimpose and align the photographs very precisely. | placed
the source images in a Layer Set named "SOURCES.” Then |
created a new “Models” set. |
copied the settings in that group

Superimposing

copies 2 and 1a makes it easier to obtain an

accurate adjustment. To do so, | used the Distort option of the

Transform Selec-

tion command

(shortcut: keyboard
Apple + T).

Pevipective
di,rlnfn,(eme»t

By holding the Apple key down, |
clicked-and-slid the stylus in order to
move the handles of copy 1a on the
edges of the model (this can be done
by using the mouse, too). The trans-
parency of the copies facilitated that
operation.

and called it Copy 2. | put it on the .e‘ ]

APLpsd @ 6.7

3% (Calque 2, Gris) O )
Ll I Layers . Paths " Channels

same scale as the one used for the
work file. Using superimposition
allowed me to make the same cor-
rections as the ones that were made
on the negative that was given to
the customer. The construction
guides (in blue) have the same pro-
portions as those of the model.

Normal =
| ook [B[F+ @]
o 13 _..I Modeis
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=
-
St age iy l
Add Layer Mask Reveal Al
During this phase, | ignored - e s |
the lining up of the sail. My Add Vector Mask >
: 8 t Hide Selection x . 2
only concern was to make : = Selecting one particular portion of the floor and
the decor of the workshop giving it a progressive contour of a few pixels al-
logical: matching, shifts, rises, and falls. Then, thanks to a selec- lows for its rotation on

TARdecor gd @ 17.4% (12 copee. Crs)

another layer that is
added to its mask. |
chose to move the small
central point of the man-
ual Transformation tool
(Apple + T) toward the
top right corner.

tion of the contours of the elements | wanted to bring in to
the picture, all | had to do was go in the Layer menu in order
to add an alpha mask.

I T R = coey -
(F = 4
_.L.*ﬂg,p TAEAERY

There was a faster solution for this. A
simple click on the Alpha Mask icon
made it possible to get the same
result in one go. By doing this, the
mask bound itself in black and white
next to the “copy 1a.”

Masnal
votativi

A (C urves adjustment layer can be added
to the preceding copy.

Once | had put the three copies together, curves
enabled me to roughly match them. | could add
a Curves adjustment layer to the preceding copy

if | wanted (once again, | ignored the aspect of
the sail).

In order to align the floor properly, it
was necessary to carry out a slight
counter clockwise rotation to com-
pensate for the displacement from the
point of view of the camera. Rather

than using the Clone Stamp, it is often T ey g | B . U
more effective to copy an area of the i L Al | | |nece] Jemm -
image instead. wovd floov i oo
[ R IERLAIENE]

gee G UNemiencownoan, . (Y | saw that it was possible to visu-

e B oo B alize each copy on the palette

T a— and follow all the operations

:‘i? ¥ f“ that had been carried out, sTep

| o ! by step. | saved the whole thing

;‘ﬁ" g::‘r under “APldecor” so as not to

SR = overload my working file (200

:¥ :g MB). This also enabled me to go

= T— ‘2 back to that file whenever |

wanted to. = E l
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The sail

To draw the sail, | followed the exact
same procedure as the one carried
out for the decor. This time, my objec-
tive was to focus on the apparent
coherence of the shape of the sail.

| placed the three copies in the
same file, with the margin | had set

beforehand, which renders displace-

ment visualization easier. As in the _ff ) rE
Al oA el

preceding stage, the center copy was placed above and would

not be moved. | would use the other two for distortion.

Actually, the floor helped me a great deal. Its boards served as
a structure. As a consequence, | was going to take advantage
of that, as best as | could, to find its original shape. The reader
can see the two slats which define the edges of the sail. They

| had to pick a common element between
the two negatives to line up. | chose the
weight at the right of image 1a as a point
of reference (this is a piece of cast-iron
used in photo studios and on theatre sets).
Because the copy was underneath, | could
precisely click on the object | had chosen
and move it. | could also match it with its
clone on the other photograph (thanks to
the Move tool). This operation was made
easier by setting the transparency of the
layer placed over this
one at 50%. This spot
became the center of
rotation which would
allow me to line up
the sail.

Transform
Scale

guided me and helped me rebuild the ground perspective, and,
as a consequence, that of the sail.

The following commands
allow for the displace-

Rotate
Skew
Distort
Perspective

Rotate 180°

It's & piece of cake, especially for
f:fw,re who have worled w?f;f{t
Pi[lvf;v.f!{lvp T e t.‘ite

ﬁ It jﬁwerﬂfﬁvw u’\.]c MMI.

ment of the central point
to the spot that has been
chosen, and for the rota-

Rotate 90° CW
Rotate 90° CCW

Flip Horizontal
Flip Vertical

tion around it: select
Copy, Edit> Free Trans-

formation. Or you can click on the right button of the mouse

or on Apple + T (which is much faster. .. )



This copy included a negligi-
ble part of the image only:
the halyard of the sail. As a
precaution, | never erase the
slightest portion of a photo-
graph. | always use the mask
to hide undesirable parts.
To keep track of the evolution
of the layers, | called in the
“small camera,” which is
located under the History
Palette and which defines a
new snapshot.

As a precaution, | never (erase

-',?wfifwj np

the sail

the slightest portion of a photograph.

If the reader observes the Layer palette, he notices that the
yellow color group which contains the sail model is deacti-
vated, whereas the distortions and masks are carried out on

the original copies, in
gray. The decor (in

Layers Channels Paths
Normal :‘] Opacity: | 100% :;4
e O 7@ fill:[100 ‘E{
> @ Sail Modals
S vy (g
[ £ Z]Lu'ves b
® 7| CEJ9TT] heeme
- al] - e
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blue) was added thanks
to a merge of the pre-
ceding stage.
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The luminosity correction curves, sometimes
added to the copy along with a mask, were or-
ange and always visible in the palette. On the
curve illustration, a dotted line defined the sepa-
ration zone for the merge between the two im-
ages. The Curve 1b correction applied to the copy
(1b center) gave the central copy a brighter
shade, which was identical to that of copy 1c
right, which, in our case, was considered the
standard.

On the Decor copy, an inversion and light transparency made
it possible to properly measure the connection quality of the
images. During the two decor and sail phases, the central copy
remained identical to the original. It was neither displaced nor
distorted. | gave both files the same pan shot space. It was thus
easy to superimpose them to obtain the final image. All | had
to do now was to finalize this image. =

Checle g the
Two-c (AA)
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Assembling the parts

We have just seen the retouching process of “sections of im-
ages” as if it were possible to cut out slices of photographs
according to the depth of the field of view: the average field
which corresponded to the sail, the background (named
"decor,”) and the foreground (which consisted of the floor and
was worked on together with the decor and sail). The model
was what led me to that slicing approach. However, the top
right corner of the im-
age still showed some

5 IDS I‘-!l' I'IS

5 95 [0
I I
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vertical defects (nega-
tive 1¢). B

Palette L
Covistyv

“Layers ' Channels " Paths

. Normal ,:} Opacity: [100% 9]

Lock Dj.}.ﬂ Fin: [100% [
- = _,‘g Group FINAL 1
Before definitively as- S B
sembling the two ma- 7 [ 8 Tl tor right
jor elements of the =
retouching phase = decor
(decor, blue copy and AL IERAE
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| quickly checked
and compared the

sail, purple copy), | re-
integrated the source
image 1c into the working file. | had two objectives during that
adaptation phase: find the same framing as for the decor and
rectify perspectives in order to rebalance the vertical lines. |
added a new mask by following the contours of the sail on the

purple copy.

source images and
the pan shot and re-
alized that something was gone. During the lay-
ers assembly, the cast iron weight had
disappeared. Thanks to a copy of file 1b and
thanks to the layer mask, it found its initial
place, along the sail, on the side of the mast.

(Sﬂ apShOtS were taken
whenever | happened on something new,
in case | had to make corrections.

Even if it was not perfect yet, | considered the
image composition satisfying and saved i,
along with all its copies, in psd format
(APIfinal.psd). Then, | made one single copy in
TIFF format (APHinal.tif), which | was going to
use for retouching. Snapshots were taken
whenever | happened on something new, in
case | had to make
corrections.

lmage

compolition



Stage
Touching up

The touching up phase is carried out on photographic prints in
the laboratory. Today, this type of intervention is no longer nec-
essary, thanks to more advanced printing equipment. It can be
done directly during the data-processing phase. Some of my
colleagues proceed right from the beginning, when the image
opens, in order to get rid of the dust that results from digital-
ization or from the original shot. For my part, | prefer to inter-
vene at the very end of the retouching phase. This allows me
to correct potential bugs that derive from the various opera-
tions that were done on the image.

The (HIStOI")/ BFUSh tOOI is extremely handy.
When it is used together with the Dust & Scratches
filter, it facilitates the correction of scratches and dust.

bw.ff
CZVJ&—M/F

Two types of bugs ap-
peared in the digitized
files: white spots which
came from the original
shot (scratches, bubbles,
and dust) and dark spots
(dust or fibers generally acquired at the time of digitalization).
History Brush is the name of an extremely handy tool which,
when used together with the Dust & Scratches filter, facilitates
the correction of scratches and dust.

In the History palette menu, | chose Options and checked the
Accept a nonlinear history box. Then, | went back to the Back-
ground layer, applied the Dust & Scratches filter
(Filter > Noise » Dust & Scratches) and gave it enough ray value
to get rid of most of the dust. | also indicated the threshold
value so that the structure of the image would be preserved.

05 'LM'LJ’, PZVIPM‘ﬁVﬂ, and Cunvves

In the History palette, | clicked on the square-shaped heading.
That enabled me to define the source for the form of history.
Its logo was thus active on the same line as the Dust &
Scratches filter. Next, | slid the cursor toward the top: the Open
heading was underlined in blue.

&~ p—

B 8 ) 1 Automatically Create First Snapshot —u—)
B s prm— 5] = = Awtomatcatly Create New Snagshot When Samey
v ® % ' asiow Mon-Linear Hstory

1 ; 2 _ Show New Snagshot Dialog by Detault

 —

Finally, | selected the History Brush
tool and set the size.
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The History Brush tool is perfect for solving dust problems.
However, since the Dust & Scratches filter tends to blur the im-
age, things are likely to get even worse if an area that requires
correction is too large. Therefore, | resort to the latest
Photoshop tools: the Healing Brush tool and the Patch tool. =

—i)
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The finishing touch

In arder to make the corrections, | used the latest Healing Brush
and Patch tools. These tools very much resemble the Rubber
Stamp tool from older Photoshop
versions that beginners or old-
T timers still use (old habits die
hard!). Just as each dab removed
the sample that had been picked,

T

\

L

;ﬂ: these new tools also require a ref-

124 ! erence area in order to apply the

I A L texture, luminosity, and shade of
. i ! the source pixels. The corrected

)7 Color Replacement Tool |

pixels are integrated with the rest
of the image and nothing shows.

Using two (SCl'eenS on my work station
helped me control the image directly.

All I had to do now was to balance the entire image for per-
fect legibility. This 180° pan shot required luminosity compen-
sation on some specific areas where the natural brightness of
the sail provoked contrasts that were too strong for a photo-
graph.

| resorted to some Curves adjustment layers (Layer-> New
Adjustment Layer— Curve) added to the copy of the image
(shortcut Apple+G or Copy-> Add to preceding copy) for which
| delimited a selection thanks to the mask.

(- 3] — =
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In order to freeze the values | did not want to modify, | clicked
on a few corresponding areas in the image while keeping the
Apple key in (dark points on the screen copy). Then, | kept click-
ing on the areas of the image that | wanted to modify. | eval-
uated the variation of the values (circle on the screen copy) and
set their extremes. Finally | took the median point and gave the
curve the direction | wanted it to take with the directional keys
of the keyboard.

Channel: Gray Channel: Gray

Input: 64 % Input: | 59 %*

QOutput: 64 % OQutput: 70 %

Name: Custom

5 - Gradient Type: Solid ?“

Smoothness: 100 1#) %

)

Some corrections
were not flat: | had to
give them some gra-
dation. In this type of
situation, the gradi-

Stops

coior [ Y

Location: |59 %

— Auto
Oatl-t-)ns
2 A7

E_l Preview

=

Cradient Editor —=
Presets ®© @
rawrry.» ne_
A"V =
Save

ent transfer Curve

command can prove

useful, but it is much less precise. By playing with the grada-
tion, its composition, its smoothness, and its transparency, |
could see right away the luminosity corrections | was making.
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So that I could view the gradation or any other layer masks, | Ca ﬁbra[ing the screen
simply clicked on the Mask control of the Layers palette. The ! ‘ o ‘ ' _
key on the keyboard allows for a quick deactivation of the mask | never mentioned the calibration of the graphic chain. It was nei-
display. Thanks to the difference in colors and transparency of ther because of some loss of memory nor because of a lack of
knowledge in that field. ICC pro-
files technology for color man-
Mogle agement is definitely the best

approach. Each entry peripheral
(digitizer, camera, efc) or exit pe-
ripheral (screen, printer, etc) has
its own profile. In order to switch
from one image mode to another
(Lab Colors, RGB Colors, or CMYK
Colors), parameters are also
specified.

this alpha layer, this intervention enabled me to better visual-
ize the progression of the gradation and the limits of the mask.

The most judicious and effective way to I"etO u Ch colors
Editing is to work on a screen that

: : S ‘ has been properly calibrated.
The image suited me and its size (14280 X 3835 pixels, or 103.4

MB) made it possible to consider various editing possibilities.
The order that had been placed required a wide angle inkjet

The most judicious and effective way to evaluate and retouch col-
print and should measure 4 ft. X 14.6 ft. maximum.

ors, is to work on a screen that has been properly calibrated in the
RGB colorimetric space. This workshop was done in scales of gray
starting from a black and white file. The color management para-
meters were deactivated since there were no colors to manage ex-
cept, for a possible conversion. =

In order to have a good quality poster, measuring 4 ft. wide
and 1 ft. high, the file simply needed to be converted in CMYK
according to the potential printer’'s expectations.

Before contacting the subcontractor for the final printing
and delivery to the customer,

| calibrated this image so that
it could be printed (inkjet 0O API_ultim.psd @ 4% (image, Gris)
print) in an A3 format (ap-
proximately 6 MB).
Throughout this process, |
sent JPEG files, to the photog-
rapher so that he had an idea 1
of how his project was coming
along.

Width : 14280 pixels (120.9 cm)
Height : 3835 pixels (32.47 cm)
Curves : 1 (gray levels)

n Resolution : 300 pixels/inch
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THIBAUT GRANIER

Hardware used

= Nikon FE2 and Coolpix 995 cameras -+

= Nikon objective 35-70 mm

= Portra Kodak film 160 NC . 5 ,VV }
= Nikon LS 2000 scanner o o J
=« Mac G4, 450 MHz biprocessor, 1 GB of RAM

Software used
= Photoshop CS
» After Effects 5.5

7:1‘ wiv[- 7 Mﬂ/ﬂ e

mong the many special effects techniques that are used
in the film industry, matte painting is the cheapest
solution. It is also the most commonly used when it is necessary
to put in a decor that does not exist
For Julien Tycoon's film Bloody Mallory, Mikros Image, a
Parisian postproduction company, carried out special effects on
over one hundred shots. | was entrusted with the creation of
three matte paintings, one of which was to represent a night Beyond the difficulty of integrating e
vision of an abandoned church, with a cemetery in the fore-  the elements in relation to one another, the CrEd!blllty
ground.

of an image lies in the creation of coherent light effects.
The atmosphere had to be eerie and haunted .

59
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The photograph

Thanks to the Internet picture library, we found the Church of
Gouzangrez, in the Oise Valley. It caught our attention for two
reasons. Its massive architecture met the producer’s wishes and
it had some badly damaged tombs—which corresponded per-
fectly with the “eerie” atmosphere that he was seeking

The problem we faced was that the most interesting shot of
the building covered the most recent part of the cemetery. It
looked too “clean.” It was thus necessary to photograph the
tombs that were damaged separately, and then resort to a
montage. Shots of the tombs were much more delicate to han-
dle than those of the building. Indeed, right from the begin-
ning, we had to keep in mind where each one would fit in the
final montage. Their position and perspective were crucial. The
fewer errors we would make during the shooting, the easier
the montage would be.
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( Weathe!" matters a lot

in rr‘s(r‘f‘ 'j“ shooting.

If the majority of photographers express the sub-
tlety of their talent thanks to the way they master
lighting, it is much more difficult to assemble, in a
realistic manner, images which do not have the
same light directions. Since none of the tombs
could be shot in the same ambient light, | resorted
to a rather simple trick: the sky had to be overcast.
Indeed, clouds serve as a huge light box which dif-
fuses the sunshine and blends it. No shadows, no
depths: it would be for us to recreate them when-
ever we needed them.
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Creating the sky

Bloody Mallory was a fantastic action
film inspired by low-budget films and
mangas. As a conseguence, some cari-
catures or inconsistencies were allowed,
such as an extremely overcast and cloudy
sky, which, nevertheless, was lit by a
strong source of light.

The initial elements that were used to
create the backdrop of the image con-
sisted of two photographs of the sky that
came from earlier shots. We placed the
first photograph underneath a copy of
the outlined church, in order to cover the
entire horizon with clouds.

The second sky was interesting because
of the clouds that were located in the
top part of the frame. Once placed over
the first sky, in Darken blend mode, it
was possible to mix the clouds together
and thus create a new sky, entirely cov-
ered with clouds.

The b,wg’lz.mv wmode e;‘.:tfia'e/ nd
fr mix rJof;t ?tw.’tqh’ l\f:‘t'rw-l-i—t
itw‘wq fv v&.n.'bf fa vufk-w.'w_?
Nr‘ (r‘ condl IJEI"wq f‘fté‘ mee(f,

L
wku ,1t~€ _;eg,., t,Elj /’ Yk 1(»&\% %4

nEl'_—*r“t” 1L ¥ o eV .‘L‘If

As for the two images of the sky, only the ( C l ou d S
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composite saturation could be low- — -
ered and thus became more mono- T 1 1 ) = ‘
chromatic. Then, a dominant color

was added by shifting the shade vari- |

I

ation and by selecting the " Colorize”

option

Since these two images

were the result of two
s different shots, they
had to be calibrated. A
conventional calibra-
tion would have necessitated the modification of one sky in
order to harmonize it with the other. However, in this case,
both had equivalent contrast ratios—only their chromas dif-
fered. Thanks to a Hue/Saturation calibration layer, the global

-—
-

Thanks to a second calibration layer in Curves
mode, it was possible to increase the composite
contrast by overwhelming the lowlights. However,
the sky should not be black. That is why we lifted
up the foot of the curve in order to increase the
value of the lowlights and make them more lu-
minous.

Layers " Chasnels | Paths

Normal $) Opaciy |

o I 7+ 8

® @,i - A

T
]

We proceeded the same way for the moonlight.

4" [::] ey Then, we added some bits and pieces of very bright
i E clouds to the sky, according to the Overlay blend
mode.

L
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not a problem, since the image did
not have too much of that to begin
with.

We followed the same principle as
when we calibrated the sky: a
Hue/Saturation layer grouped with
that of the church made it possible
to lower the saturation of the
church. However, we did not rede-
fine its color, since it was important
to keep the original colors relatively
intact. That is why, this time, the
dominant color was affected by a
light opaque layer (50%) which
contained some color taken from
the sky. By the end of this stage,
the church and sky definitely

“American night” calibration

American night (often called “day-for-night”) consists of film-
ing a daylight scene by under-exposing the image and by plac-
ing a blue filter in front of the lens. This is also widely used
in digital special effects.

In order to under-expose the church, a calibration layer
was created for each curve: a point was then selected in the
middle of the layer and sharply lowered in order to make the
image more dense. As a result, the slope of the curve in-
creased in the
highlights area
and that gave
them more con-
trast. That was

looked more homogeneous. Never-
theless, we kept all these adjust-
ment layers as they were, so that
they could be modified whenever
the rendering would require it.

i
4

Tl 1 |

It was important to keep the original (CO | ors

I A relatively present

-

64
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Making up the cemetery

The making up of the cemetery was a special phase. As we
mentioned in Stage 1, numerous negatives were taken and
they did not always have a similar exposure. Little by little, tomb
after tomb, we selected the elements that we found interest-
ing. We outlined them, calibrated them, and distorted them in
the image foreground

Photoshop’s weakest point is layer distortion. The only major
tool that could be used was the Transformation tool. Unfortu-
nately, it offers very few possibilities when we compare it with
the type of tools that come with After Effects, for example.

That is why each added
element could never be
dominated by the infe-
Throughout this process, we had to keep in mind rior layer of the church.
that the image carried out with Photoshop was only
the preparation of elements which were to be as-
sembled and animated, using After Effects. Indeed,
the sky was going to move and fog would be added
between the tombs
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Shadows

When we were taking care of the sky, we suggested the pres-
ence of a strong source of light (the moon) located in the top
right corner of the frame. Consequently, we had to create the
shadows that derived from that light and which would consti-
tute the densest parts of the image.

When we duplicated the copy of the church and put it under
Multiply blend mode, its density sharply increased. The values
that had been reached corresponded to the levels that we
wanted to attribute to the shadows. By adding a black mask
to the copied overlay, the lat-
ter disappeared entirely, re-
vealing the original church
underneath. It was in this
mask that we were faced with
the most delicate task: using
white flats. Using either the
lasso or the brush, we had to
restore all the areas of the
church that were not lit and
that had been darkened by
the various shadows that had
been added

< ores hadem

Here is a trick: we applied colored effects to the masks of the
shadows we had just obtained. For example, the shadow ef-
fect made it possible to create various color gradations (blue
on the illustration) all around the shapes we had just outlined
We matched the colors we had just applied to those of the
source (white) and shadows (generally blue). Now, if we se-
lected the proper blend mode, it would be possible within a
few, simple actions to give the shapes richer, yet irregular light-
ing effects without having to retouch the whole thing, step by
step. The last image shows the result that we obtained

f I
The thadew

mAad K

to the shapes.

Once the same operation had been carried out
on each layer of the tombs, we could start
thinking about the final rendering of the decor

00

i e

-
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Final touch

vas essential to polish up the ren-
ng and improve the integration of
he various elements in order to ob-

ments had been correctly calibrated,
overly sharp outlines would show.
Therefore, each mask had to be care-
fully checked and cleaned of any im-
ections. Potential blurry effects,

due to relative distances and depth
of field, also had to be taken into ac-

count

Even when we believe that the ae CO¥

" finally represents

an h-O-"“GgE‘”E-OL.-S universe,
E:

the job is not quite

-
-
-
-
-
-
-
-
-
-
-
-
-
-
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Let us not forget that other people
were going to take over. This im-
age had to undergo new modifi-
cations and it was not meant to be
viewed on a computer screen, but
in movie theaters.

In order for the special effects
person to integrate the animation
effects he was going to add using
After Effects, it was basic to make
our project as simple as possible.
So we fused as many layers as we
could and still ended up with more
than 15! The special effects person
could probably use the shadow
masks: we saved them all in the
stack of image layers

All we had to do now was to check that the images matched
the output calibration profiles that are specific to the cinema.
In the case of our church, which represented an extremely dark
universe, the wrong set up could have disastrous consequences
when viewing time came: the risk was that nobody would see
anything
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Hardware used
= Nikon Coolpix 950
=« Mac G4
= Electronic paint system

Software used
= Photoshop CS

N /i ost of the time, retouching is used to perfect a
# ¥ ¥ photograph that is already structured (composition and
lighting). The retoucher’s goal is to render the effects of his
work as discreetly as possible. The choice | made here was to
use all the potential that retouching provides and apply it in the
same way an illustrator would. | was to create a surreal universe
based on a “realistic” shot.

Yet, the realization of this image made it possible to tackle
almost all the aspecis of traditional retouching: outlining, skin
cleaning, and—more generally—as well as lighting and col-
orimetry.

Fival image

| was to create a surreal (U nIV€ Fse
based on a “redlistic” shot.

09
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Preparing the ground

This essential phase may seem tedious and unsatisfactory. It
consists of using various handy tools that allow one to outline
different types of shapes and surfaces (hair, skin, armchair).

This m,eh’wdicwl worlc pmvwf to lee ver
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Experience has taught me that the better the preparation, the
better the final result. That initial preparation enabled me to
better concentrate on each following phase (cleaning, format-
ting, lighting effects, etc.). The work ended up being a ot more
constructive.

| started by outlining both the
character and accessories com-
pletely. The Pen tool allows for a
very precise outlining of contours.
However, it does not work as well
with shapes which are not clearly
defined or which are very fine
(hair or blurs). What | did was to
outline them roughly.

Once that was

done, | masked the background. | applied a Gaussian blur in
order to soften the contour a little while respecting the sharp-
ness of the shot.

rA\ I

The second outlining phase was carried out in Quick Mask
mode with the Airbrush tool. It completed the work | had just
done since it enabled me to focus on softer, or blurred con-
tours.

Experience has taught me that the better the ( pre par‘atIO n ’
the better the final result

The third outlining
phase required the
Smudge tool, which
allowed me to stretch
the surface of the
mask so that it would
perfectly mould the
irregularities of the
forms | needed to
outline. Therefore, |
had to push the mask
between the areas
that were “frayed,”
such as her hair, as
much as | could.
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Cleaning

It was during this phase that the first spectacular effects of re-
touching would start to show. However, before going any fur-
ther, | still had to spend some time "dusting” the image. No
matter what kind of original support you work on (scanner
based on an ekta or a negative, or digital shots), there is al-
ways some dust that needs to be cleaned by using the Clone
Stamp tool. That's the final “chore.”

! fvw,‘,ﬂ‘{ WU MMOVE Tl fv o rve Jevivnd m:bf,’f?tvf,..

- % Clone Stamp Tool S
%% Pattern Stamp Tool §

.

Smoothing should remain ( m Od e rate for
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a natural touch.

Smoothing makes it possible to attenuate
the grain and skin imperfections as well
as the irregularities of certain surfaces.
Skin smoothing can be more or less in-
tensive according to the type of render-
ing the artist wishes to achieve: moderate
for a natural touch and extreme for
“glamor” type renderings, as is often the
case in photo advertising for cosmetic
products.

As for my character, | chose an interme-
diary approach, since the lunar lighting
effects that were to come would empha-
size the smoothed and slightly artificial
aspect of her skin. | used the Clone Stamp
tool to smooth her skin and worked on
the opacity according to the effects |

wanted.
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Stage J .

Updating

Next | had to simplify the forms and give the
whole thing a more elegant feel. That gave me
the opportunity to renovate and repair a 30-
year-old chair that definitely showed signs of
wear and tear.

With the Clone Stamp tool, | duplicated the
“healthy” parts of the chair in order to patch
up the parts that were damaged.

B = 2 Cione Stamp Tool Y

g Pattern Stamp Tool S §

First of all, | selected the part of the

seat that | wanted to distort.

| took advantage of this stage to get rid of the folds in the tee-
shirt, which could make the model

look bigger than she was. | also re-
duced the apparent thickness of her
arm that the angle of the shot had
created. In order to do that, | simply
“cut out” the undesirable parts.

It was also during this phase that |
gave the chair the shape | had
planned to give it when | designed
the image, before | shot it.

‘4 S—

Then, | gave it the chosen shape by apply-
ing a distortion.

The graft and distortion phase was almost
gver now. However, | still had to add some
grain where the distortion had produced a
fuzzier image.
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Creating the starry sky

It is often easier to
Create your own
starry sky and Milky
Way than to photo-
graph them

| created an addi-
tional layer and filled
it with a bluish, black
flat. That would be
my night Coments

Fill

Use: | Foreground Color ¥

On that same layer,
with the airbrush, |
started to paint the
edges of the Milky
Way in a lighter blue.
| picked a wide,
slightly opaque brush
to do that.

Then, | switched to a bluish white shade and a slightly narrower
brush to give a fuzzier aspect to the heart of the Milky Way. |
applied the color in successive dabs.

Next came the stars . .

In order to simulate the depth of the universe, | decided to cre-
ate stars which would be different in size and sharpness.

/ H
The compedition acf the lackdvep

wid Aetermined {4j Ht,e Ju{ﬁ_ie({:.
Ej n{fbﬁwj H&e M;“"‘j NA,;’
ﬁ;"lﬁﬂawﬂ/”j e &'E[:«‘v{ﬁvw 1';\7 the

!
. ) - . {;H—f\}b
image, it gave the impredliow

Ht& CJL\{W[L{,‘IEBV wiad mvv?wﬂ,

Fal imaﬁ ¢
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| added one layer for the most remote stars, which would be
the fuzziest. With a small brush, | painted small, sharp dots be-
fore giving them a Gaussian blur

On a second layer, the stars in the foreground would be the
sharpest.

On the third layer, | gave each star a bright halo by using a
low opacity brush in order to diffuse contours.

Finally, so that some stars would twinkle more than others,
| decorated them with a particular sparkle, a sort of vague as-
terisk, to make them scintillate.

Filter
Sharpen

Blur

Distort

Add Noise...
Pixelate
Render Dust & Scratches...
Sharpen Median...
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S-tage |

74

Colorimetry

Much more than with mere color changes, colorimetry helped

me reproduce the lunar and fairy-like atmosphere. Severa

adjustments were necessary to reach that objective

When retouching entails major modifications (smoothing of the
skin, mending, formatting the elements, etc.) colorimetry is es-
sential. It gives the image its personality.

When | work on this type of color retouching, | al-
ways bear in mind the kind of final support the im-
age will have (printing or Web page). Here, the
paper print implied that, right from the start, | had
to operate in CMYK mode.

The image condd wot lte converted at

tti«e end a\{'- ﬁ;te Vt‘-tvw('r,t?wj proceld,

[

l4ecasnte Jw-itc;ﬁt-i»g {:va vine mode to

ftwiiitﬁw (R[('B fmﬁ’( (:M—fd F’-) rowlﬁ-(

I’E’{LA’ f;v trfte /VJ'J o{' (EVl‘,'."ti»v

1 w[vfmfbfﬁvw .
N

| used adjustment lay-
ers which gave me
great freedom of ac-
tion. | was able to go
back to each phase
without having to
worry about the differ-
ent stages of the his-
tory.

Consequently, | accu-
mulated color correc-

New Laver Based Sice

Add Laver Mask

Add Vector Mask

Grayscale

RGB Color
¥ CMYK Color
Lab Color

Muitichanne!

B v 8 Bits/Channel
16 Bits/Channel

Convert to Profile

Source Space
Profie Cro-Dig_PeissonBougece

Cancel_
Desunation Space

# Preven
Profile:_Working CMYK - Cro-Dig_Poissenfioug Bl

Comeriion Cptons
Engine. _Apple ColorSync ]

cent Perceptual )
" Use Black Point Compensation

 Use Dither

The last corrections
enabled me to
make specific modi-
fications on each el-
ement, without
spoiling any of the
effects | had already
given them.

tions without having to resort to outlining again. Eventually,

that could produce undesirable edgings on the image.



| selected each element and attributed it its own colorimetry
curve (using the Curves tool). The difficulty lay in the fact that
| had to respect the way each texture and each surface would
absorb or reflect an “astral light.” | thus picked a velvety ren-
dering for the skin and a shiny one for the leather of the arm-
chair.

Levels.. =L
Auto Levels XL
Auto Contrast O XL

It was necessary to preserve the freshness of the skin while
bathing it in a bluish light. | decided to give more blue to the
shadows and to preserve the velvety and slightly rosy aspect of
the lighter parts.

The colorimetry car-
ried out on the arm-
chair completed the
preceding phase. |
had to avoid giving
the skin too much of
a bluish shade or it
would look morbid.
To compensate for
this | enhanced the
blue on the armchair. To finish, | accentuated the shine of the
leather in order to underline the glitter of the stars and evoke
the reflections they should cause on the leather.

07 —F?vejf/j l

Stage
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| also wanted to transform her stockings into “space boots”. |
thus gave more density to that part of the image until the tex-
ture of the mesh
completely disap-
peared and took
on a uniform and
smooth aspect.
| enlarged the
folds around the
ankle to give the
illusion of a
thicker material.

Orange-red was chosen for her hair to balance the whole

image. This warm color gave a softer look to the character. By
the same token, it gave the image a central focal point. Indeed,
that orange-red, a complemen-
tary color of midnight blue, high-
lighted the whole picture thanks
to a colorimetric contrast. The
goal here was to focus the atten-
tion on the character.
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Harmonizing the whole ’ & :
, , vajtm'wj mundt feewm fo
The last stage in the completion of the image was its harmo-

nization. The time had come to polish it up. Usually, it is a mat- Aevive fwm her.
ter of retouching a few details here and there that reinforce

and complement one another. Here, everything was done

thanks to the Airbrush tool.

| started by wrapping the
character in a luminous
halo. This is what helped
produce that luminescent
aspect, as if the light em-
anated from her as much as
from the stars. It was also a
means of exploiting the ; ' IR "
depth of the image by put- : - Feather Radius: 50| picels (ORI
ting the character in the ¥ . _Cancel _
forefront, when compared

to the armchair.

It was also necessary to reinforce the reflections.
To do so, | picked a low opacity brush and ap-
plied specific halation here and there to give the
illusion that the light emanated from the image.

| added a sparkling effect in order to blend the
character into the decor even more and stress
the fairy-like evocation. To do so, | used a very
small, hard brush and painted spangles.

I thickened the nebula in the center of the im-
age, in order to give even more intensity to the
brightness of the character.

LEEEREDRDED




Finally, | made the sky and stars slightly

fuzzier. As a consequence, the charac-
ter looked sharper

It is fdwmj; w good idea
to talee n lpreade and qet
frisf menu Hte ?mﬁﬂ&
ffw a while and allow
the eye tr vest. Evevj
protect if fo[wf«ji
pevfectilele, lnt it is
Iv[.fv w%&,r.mwj tv Z:iww

wlitl’:n {,‘v J‘f;vp.

Brightness:
—————o————

Contrast:

0 7 o 'Fi'm’:ffj I

Stage

| applied one last (CO'O I”l metl’)/ curve (using the Curves tool)

to reinforce the colors once again.

After taking a short break, |
came back to the screen. | got rid
of a few bugs in the reflections.
| applied one last colorimetry
curve (using the Curves tool) in
order to reinforce the colors
once again and | regulated the
shadows and light values.

i
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Hardware used
= Sinar P 4x5 view camera
= Provia *Fuji film
= Lighting sources: lighting box
= G4 dual-processor 533 MHz
= 1.5 GB of RAM
= Gretagmacbeth Eye-one spectrophotometer

Software used
= Photoshop CS

n order to illustrate this studio, | chose an image of beauty

products which clearly showed the different problems one
regularly confronts when retouching studio shots. These were
some of Yves Rocher's Aroma cosmetic line. The advertising
agency, Lowe Alice, is very demanding when it comes to the
guality of the images. It demands esthetics and meticulousness.
The products that are photographed must be readable and
identifiable straight away. In order to meet that objective, the
agency called on one of the most famous still life
photographers, Christian Cournut.

My work then consisted of making this image more read-
able by removing the typography on the back of the products,
which were transparent, and in harmonizing the reflections on
the bottles.

CYRIL BRUNEAU

A VoA

FF’i wﬂvl imhﬂ e

It is necessary to work on the ]eg’ b” Jt)’ of the image without
betraying the products themselves.

Lt
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Stage

The shot

If the finality of the work presented here was the retouching of
the image, it was essential to take a closer look at

the shot itself. In this kind of retouching it is
very important to know what you are look-
ing for, right from the beginning: the
fewer manipulations on the original
photograph, the better

the quality of the final

image.

M oy
\
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The products were set on a very clean mirror in order to have
beautiful reflections. They were lit thanks to two sources of
light, called light boxes. These are boxes that are closed by a
Plexiglass plate, inside of which several large flashes are placed.
They provide-a diffuse and homogeneous light.

The largest box was placed behind the products so as to give
a nice, white support and transparency to the bottles.

A second box was placed in front of the products, to light them.
However, the latter was slightly off to the side to add contrast.

RE\{: j éC ﬁwf

Vﬁ e (AMMEVA
é__,__..

Then, by using several white card boards of various sizes, the
light was reflected on areas that were a little too dark, or to
create slight gradations. On the other hand, black card boards
would stop the light. This technique enabled us to direct the
light in a very precise way and create beautiful reflections in
the liquids. =

The etymology of (“ to phOtogFaph ”means:
to write with light . . .

p— 3|
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Preparing the ground

It is always best to set a work scheme
right from the beginning. It is very im-
portant to think about the way you
wants to reach your goal in order to
avoid doing things unnecessarily. Very
often, when the retouching work is
finished, the customer, or the agency,
require modifications—and that is
why it is necessary to plan the differ-
ent steps of the project.

Here, for example, | indicated that
| wanted a white gradation in the re-
flection. My choice might not corre-
spond to that of the agency: it might
prefer a lighter, or denser gradation.
That is why | put that reflection on an
individual copy so as to regulate its in-
tensity later on.

it it eadier tv mde.

| decided to work in RGB and to con-
vert everything to CMYK at the end
of the work. That way, if the photo-
engraver decided to do the conversion
herself, in order to adapt it to her
printing machines, | would be able to
give her an RGB file without having to
start all over again

st ®

The fcveenw weedl 1o [se V'C’—Cyv['\lﬂlffbtﬁ’t;
wite v&e», lsecanse its valwes
(mwje with time.
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that each weelt.
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First of all, | calibrated my screen to make sure my colors were
all right. I used the Gretagmacbeth Eye-one to do that. It is very
important to work on a properly calibrated screen, since you
use it in order to adjust colors. Of course, the products in the
photograph must without fail have the same colors as the real
ones.

ment device i3 placed on the mea-
surtmen: wingon.

(a)
=)
o
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This is how | was going to proceed: outline all the products and
their reflections, remove the typography on the back of the
products as well as the unwanted reflections and, finally, work
on the white gradation.
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Outlining :

It is imperative to master outlining well in order to do a good
retouching job. It must be precise and it often takes time. There
are several ways of outlining an image. For the bottles and their
reflections, | picked the Pen tool in order to carry out a precise
selection. This tool works very well with geometrical forms.

.
[¢}E

The Pen tool is delicate to handle at first, because it is difficult
to learn how to use the directing points and anchoring points

properly. ‘PVE(;J& vh«t{fu?m—j Nltﬁ{t ttite P&w

However, it is worth some perseverance. It is one of the most
precise tools available and often provides very good results.

A Once | finished, all | had to do was transform it into

: a selection. In the options at the bottom of the paths
palette, | chose Create a Selection from Path. | picked
a 1-pixel radius in order to have a rather clear-cut
selection.

sion and does not provide quality results.
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Stage.l .

Creating a layer mask

Now | had a selection based on the products. | transformed the
background layer into a normal layer by clicking on it twice. It
is not possible to apply a mask on the background layer. |
named it “Products.” | clicked on the “Add a Mask” icon, at
the bottom of the layers palette. The outlined products ap-
peared.

B G0NGE v P 2% 4 e TN o 3 [
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Next, | created a
new layer which |
filled with white. g
Inamed it “Back- =
ground” and | [
placed it under-
neath the Prod-
ucts layer so as to
give the image a
brighter appear-
ance than with a checked background. This also made it eas-
ier to see potential flaws in the outlining.

| prefer to use a mask rather than eliminate a part of the back-
ground which does not interest me. The mask also enables you
to come back to a selection if need be.

When in Mask mode, it is possible to refine outlines by paint-
ing the areas you wish to hide in black and the parts you wish
to reveal in white. This could not be done if the background
had been erased.

he majority
mask and do spend a lot

transparencies, gradations, blurs, or co
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— With the lasso, | made a rough selection around the letters,
then | took a sample of their color with the eyedropper tool.
| S In the Select>Color Range menu, | saved a selection of the
letters that | wanted to keep. By moving the tolerance, |
S t a g e L | stopped on the value which not only gave me white letters, but
really black bottles so that in the end, the computer would se-
Prorecring T_\'[)Ogl‘ﬂph,\' from the rear lect the letters alone. | quickly got a very nice selection.
Seeing the quantity of the characters
that needed to be erased on the back of P g ——— - " K
the first two bottles, | decided to re-do TT e e e et | 3 [t ostroses Covr Comn

the liquid inside, rather than remove
each letter one by one.

&~

ik Color Range

Select: #* Sampled Colors _:f F oK )

Fuzziness 129 Reset

NS ISONCY,

@ Selection ) Image

Selection Preview: None

In a new layer that | named “Inside bot-
tles,” 1 would recreate the color of the
bottle. First, | had to allot a mask to that
layer in order to protect the areas | did
not want to touch. All that would be in
black in the mask would be preserved

In the Layer menu, | selected Add Layer Mask for the selection. |
proceeded the same way for each letter and each vertical edging.
This would enable me to paint my reflections while preserving the

{’t&w

It Aves fave LFme w i
o f'-(.wt?w ‘HMZ IJ{tVVt-Cw{ZJ v
l [ ﬁ” Hj nV&Vﬂ’wiZJ
the lceqliponra - ‘ F N oy i
ags g"”" Aisplacing the Protecting the background
i‘”"f:* . HW tf"{“i*{ﬁ - The background also had to be protected in order to paint only on
t, ersnd. 1t whi phlows yor the products. To do that, | recalled the selection of my products
ne menwind.

: again by clicking on the Products layer mask, while pressing the
174 o Laiac el Command key. The product selection appeared on the screen.
leveew secante I Then | inverted it (Cmd+Shift+l) in order to keep the background

(s e closed. selection only. Once the Letters layer mask was activated, | selected
black as my background color by pressing the D key. | filled the
selection with that color while pressing Alt+Return.

vooua Vi f;i"v&
L & pfv!'eh(:e‘r
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Stage

Recreating the inside of the products

With the Pen tool, | T e L Retouching comes in whenever something cannot
made a selection of the &= : ‘ be done through a direct shot. Here, the photographer
mauve area | had to S took a picture in which the light was perfect for four
work on. e bottles out of five. When he regulated it to take the

S e

FRlAA NN N

" ] last bottle, the other four did not look as nice. The re-
| started by painting in EJ - toucher is able to obtain an image in which the light
mauve with the brush, 5 on each product is exactly where the photographer
very roughly, in order - wants it to be.

& hcinioy Tk En Wmagt Lo Sk e view wWindow Helo [l 0 . | thus outlined this new bottle and applied it on a new

P e e e . . -

= 2 layer in my image. | used the Displacement tool so that

o i | could place it precisely over the other layers.

W to get rid of the ;

SE letters on the back .! Photoshop File Edi image. Layer Select Filler View Windo] Then | reduced its opacity

o5 of the bottles. TRl t0 50% in order to see the

;j;j With the eyearap- : . product that was under-

E per, I made sure to wr : neath and to position it

e A D ) select exactly the $17] gro® exactly where it should

i ' § same mauve color. '”f?‘ 0 be. With the Transforma-
e tion portion of the Move
3.2 tool, | gave it a slight ro-
- tation (the scans were not

Then | took a fairly large brush ke 10 £ positioned strictly in that

(30% opacity, with a 50% flow), . i same way).
and played with the various
mauves to recreate a liquid with
all the nuances and gradations it
might have.

[fjvw (s € Htt
avveond vie f;JiM?

[;’.e {d-w%r/ tr move Hﬂ‘
h‘vjer witf‘x extrveme
precidivie thvre
Iv;’«.!?d{o{?iuq the

f;v‘fvw,rfo Vm."vﬁv [P

& Photoshop File Edit View

£iv | g i

| did the same with the reflec-
tions. With the bottle on the left
it was even necessary to create
new reflections to make it more
“attractive” and give it more
presence. The photographer had
shown me a version of the pho-
tograph taken under a different
light. It would work better for
this bottle: the reflections were
more harmonious and the large
black flat has disappeared.

+—
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@ Photoshop File Edit image
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Layer Select Filter View W

=

As in Stage 5, | pro-
tected the letters on
the back of the bot-
tle and selected each
color.

It is very difficult to preserve both the material the bottles are
made of as well as the appearance of the liquid. Usually,
whether you are touching up a face, a product, a sky, or
anything else, the problem you encounter is preserving the
material. Photoshop is a very powerful tool but it is not
“magic,” unfortunately. It requires know-how and patience

RS ]

This step was particularly important because | need to recreate
the inside of the first two products. The reflections had to look
real. They had to correspond to the atmosphere the photog-
rapher wanted to instill through the type of light he had cho-
sen. Of course, the same modifications had to be made in the

reflections of each product. =
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Stage |

Inserting the candle

Once | had outlined the candle on another photograph, | ap-
plied it on a new layer that | named Candle. | placed it beneath
the Products layer in order to put it behind the cream jar.

Looking at the can-
dle, | noticed some
unsightly reflections.

| would touch them
up on a new layer
called Candle reflec-
tions (it was better to
do this on another
layer to be able to re-
turn to it, in case |
made a mistake).

| started by calling
in the selection
of the candle
(Command+click
on the candle
layer) to touch it
up and was care-
ful not to go over
the edge of the
background.
With the Clone Stamp tool, | removed the unwanted reflec-
tions and created a more harmonious glass rim.
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It is important to make sure that the ( Use a” |a)/erS
option is activated.

¢ Layer Select Filter View Window Help

To give the
candle wick a
fresher look, |
used the lasso
and selected
it. | chose a 5-
pixel toler-
ance so as to
have a rather
progressive
selection.
Once | got the
right selec-
tion, | chose a Luminosity/Contrast adjustment layer: | added
quite a lot of luminosity but little contrast. =
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Stage| .

Unsightly reflections

On this image, one can distinguish two kinds of problems: small
“sparkles” and more significant reflections.

| usually use the Clone Stamp at 100% to remove dust and
small “sparkles,” then come back to what | have done with the
same tool but, this time, | used it at 30%, in order to remove
what could still be seen.

_%'e'l | # B — T) Ovscw [160x [B) | Flow (00 [B) [0 | aigeed & use Aoy

To correct the most visible reflections—where the cream
jar reflected in the bottle—I selected the part that | had
to work on with the Pen (Line) tool. What interested me
here, was the border between the two color areas, be-
cause | wanted to create a reflection with a progressive
gradation. When one looks at the mauve color in the
center and at the darker mauve color on the right part of
the bottle, the transition between the two is progressive.
It was extremely important to preserve that transition
so that the retouching phase would look as realistic as
possible
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had bo le Aowe vemains as Aiscreet as possilele.
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wwde have to lse C;weFu— y de lected.

T Fhowihop Fie Eor mag® v SHeq e View wind Once the lining phase

pusmer (350 | st

the Return key.

With the polygonal
lasso, | selected the
retouching parts that
had been gone over
by moving along the
right side of the bot-
tle. l erased them with

was over, | chose
Load Path as a Selec-
tion at the bottom of
the paths palette.
Within that selection,
and on a new Reflec-
tions bottle 4 layer, |
removed any un-
sightly reflections that
were left from the
clone stamp and the
brush. | masked the
selection (Cmd+H) to
see what | was doing.
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The white gradation
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| was going to create a gradation which would let the reflec-
tions of the products show progressively. | placed a new layer
named “Gradation” over the Products layer and then picked
white as the foreground color. With the Gradient tool, | se-
lected a linear gradation between the color of the foreground
and the transparency. Finally, | started at the bottom of the im-
age and stopped at the base of the large bottles.
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You can see that the gradation went
over the small bottle in the foreground.
It was thus necessary to create a layer
mask in order to hide that part of the
gradation. The first thing | did was to se-
lect the small bottle with the Pen tool,
which was ideal for a geometrical form
like this.
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| transformed the line into a 1-pixel selection (so
that it would be sharp).

In the Layer-Add Layer Mask>Hide Selection
menu, | again changed it to a mask. That gave the
impression that the gradation had gone behind the
bottle.
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Stage. .

Final touches and verifications

I went through the entire image once again to check if there
were any flaws that | had to eliminate (such as dust, an out-
line that was not quite perfect, or a layer that had moved). This
was an essential phase since | did not want to send a file with
errors in it to the printer.

Therefore, | looked at each part of the image according to the
real size of the pixels by clicking on the magnifying glass (or by
using the Cmd+Alt+0 short cut on the keyboard).

| started at the top left-
hand corner of the image,
and very meticulously

08 —Aroma I

In a new layer named 4 F'nal tOUCheS:. | got rid of
all the small flaws . . .

scanned it with the Begin- , f4e;’?eve ti‘f‘vf t;ku te.(!ﬁw;ﬂwe ane that was done, | sgved my image with all
ning and End arrows. These ; f T th its layers on my hard disk. | sayed a flattened
i e i 1§ mngh move Vjoreis version of it (in TIFF format, wwthout compres-
tire image and not miss a fing the Hasd tovl. sion) once | had removed all the lines. That one

single thing.

In a new layer named “Final touches,” | got rid of all the small
flaws by using the clone stamp. Of course, | placed that layer
over all the others.

I then printed the image in on A4 paper from my photo printer.
This enabled me to spot details | might not have seen other-
wise.

was for the photoengraver. The retouching
was now entirely done . . .




CYRIL BRUNEAU
Photographer, retoucher

Cyril Bruneau is a photographer in the advertising and illustra-
tion fields. He discovered the digital tool ten years ago and saw
it as a fantastic means for creating his images. Today, people
contact him regularly not only because he is an excellent pho-
tographer, but also as a master of the art of retouching and
creating photomontages.

He has worked for some of the world’s most famous com-
panies (including Disney, Yves Rocher, Cartier, Société
Générale, Air France, and Vinci) as well as for various maga-
zines and newspapers (including Paris Match and Le Monde).
www.cyrilbruneau.com

THIBAUT GRANIER

Retoucher, photomontage and
special effects technician

As a freelancer, Thibaut Granier works primarily for audio-
visual postproduction and various news organizations.
tibog@free.fr

DOMINIQUE LEGRAND

Trainer/expert in digital imagery
(Trait d’union graphique Company)

With a degree from the Estienne School, Dominigue Legrand
is a specialist in photoengraving. He trains people to use Adobe
Photoshop and color management. He is the author and edi-
tor of a reference guide, Printed Color: Directions for Use, as
well as several CD-ROMs on self-training, including Photoshop
know-how. He is also the president of the Photoshop Club in
Paris.

ANTONY LEGRAND

Image creator
Antony Legrand has a communications and graphics back-
ground. He participated in the design and writing of Studio 2.
www.clubphotoshop.org
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ERIC MAHE
Image creator

Eric Mahé has been a photographer and data processing spe-
cialist for more than twenty years. A Photoshop buff, he has
not stopped exploring the digital universe since discovering
the potential that digital tools provided him to retouch his own
images.

emmahe@club-internet.fr « www.ericmahe.com

GERARD NIEMETZKY

Adviser and trainer in color management
and digital printing

Gérard Niemetsky graduated from Louis Lumiere in 1978. He
worked in different laboratories before creating his own group
of professional laboratories which he ran until 1996. In 1980,
he got involved with the development of micro-processing, and
in 1990 in the development of digital images. When he was in
the U.S. between 1998 and 2002, he devoted his time to the
development of a color photographic process by mixing a 19th
century coal process with the latest techniques in digital imag-
ing. Back in France in 2002, he wrote the first French book on
color management, published by Eyrolles Editions.
gerard@gestiondescouleurs.com * www.gestiondescouleurs.com

FRANCOIS QUINIO

Author of images

Francois Quinio has been fascinated by photography for 45
years. He teaches professional photography and is always on
the lookout for new developments in his field. His attraction to
novelty pushed him to meet the photographers and suppliers
who have been long-time believers in digital technologies. He
became an adviser and participated in the development of the
first studios equipped with digital sensors. Today, he leads a
more secluded life but keeps on making images and sharing
his insights.

francois.quinio@wanadoo.fr




POISSON ROUGE
Digital retouching studio

Poisson Rouge, a studio specializing in digital retouching, pho-
tomontages, graphic creation, and visual communications, was
founded in 1997. In 1999, they added a 3D-creating cell. Most
of the images made by Poisson Rouge are produced in collab-
oration with photographers and/or advertising agencies. Pois-
son Rouge works alongside photographers right from the
design phase, and maintains a close relationship with the
engraving specialists to ensure optimal quality in the printed
images.

www.poisson-rouge.fr » poisson.rouge@wanadoo.fr

VINCENT RISACHER
Photograver-scanner specialist

Vincent Risacher trained as a photoengraver and scanner spe-
cialist. In 1992, he started his own business in digital image
processing. He has his own workshop and teaches in various
training centers. He is the author of several books on Photo-
shop (published by Eyrolles Editions). Adobe qualified him as a
Photoshop expert and since then, he has started a collection of
graphics resources named “Goodies” which are accessible on
his website.

www.photogoodies.com.

THE TRANSLATOR

MARIE-LAURE CLEC’H
Translator

Marie-Laure CLEC'H started her own translation company in
1984 in Washington, D.C. Her clients included the U.S.
Department of Commerce and the Agency for International
Development. In this capacity, she also taught French to U.S.
State Department officials. She is now established in her native
Brittany (Western France), where she has created a new
company called English Translation Services.
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Computer Graphics/Photoshop/Desktop Publishing

IT HERE,
FROM THE .
BEST. <
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CAN $36.95

00860-0

US §24.95
ISBN O

0-596-

HOW CAN YOU digitally restore old images, improve
your holiday photographs, work with a colorimeter,

retouch a subject’'s face, blend together several images,

or simply enhance images that you have created? By
using Photoshop to retouch your photographs.

The authors—freelance photographers and photo
retouching agents—present workshops demonstrating
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the step-by-step creation of their works. From review-
ing the initial order, collaborating with an artistic
director, choosing the format, to presenting the type of
impression the image should create, experts in the field
take you through all the stages of photo retouching.
This book provides a professional’'s view of the heart of
retouching with Photoshop.

Designer Notebooks

Every aspect of digital creation by leading digital media experts

This series is designed to inspire and instruct illustrators,
graphic designers, photographers, and all professionals
who create images, whether still or animated. It reflects
the best in the world of digitally created images.

T





